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PARTS OF A COMPUTER 

LEARNING IN THIS CHAPTER 

• How does a computer work? 

• Parts of a computer  

r What makes a computer powerful? 

r Disadvantages of a computer 

A computer is a useful machine. It is used in almost every sphere of our life. We can play games, write 

letters, draw pictures, listen to music, store information, solve sums, etc., on a computer. It can work 

very fast and can do manyjobs at the same time. 

In the previous class, we learnt about the use of computers in different fields. Let us quickly revise 

some of them: 

Animated Movies 

Figure 1.1:  Uses of Computer in Different Fields 

A computer is one of the greatest inventions of mankind. It performs the following functions: 

INPUT Accepts data given by the user 

PROCESSING Works on data according to the instructions 

Gives the desired results 

Stores the information 

Learning 
Computers with  KPS 



OUTPUT PROCESS 

INPUT OUTPUT PROCESS 

HOW DOES A COMPUTER WORK? 

Every computer goes through the followingthree stages: 

I N PUT 

The data and instructions, which we enter using a keyboard or a mouse into a 

computer, is called Input. We can enter numbers, words, pictures or sounds as 

input. 

PRO CE S SING 

After entering the data and instructions in a computer, the CPU works on the 

input to give us meaningful information. This is called Processing. 

OUIIPUT 

The meaningful information that we get after processing is known as Output. 

This Input Process Output (IPO) cycle can be understood with the help of an 

example. 

Suppose, you want to calculate the total marks of different subjects on a 

-, computer. See, how the processing takes place in a computer. 
Example 

90, 85, 69, 98, 76, 84 + 

Data and Instructions 

The first step is to input data 
and instructions, i.e., marks 

and plus (+) symbol. 

90 + 85 + 69 + 98 
+ 76 + 84 

Then, the computer works on 
the data on the basis of given 

instructions. 

On the basis of the total marks obtained, the teacher calculates the percentage of a student and finds 

his/her position in the class. 

Likewise, we also perform various tasks by following the Input—Process—Output (I P0) cycle. 

Let us understand it through some day-to-day examples. 

What are the steps that your mother follows when she prepares a cup of tea? 

Look at the example given below. 
Exam p1 e 

502 

The computer gives 
meaningful information 

or result as output. 

Boil water, 
tea leaves, milk, 

and sugar. 

Tea is ready. Take some water, tea 
leaves, milk, and sugar. 
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Charles Babbage is 

regarded as the Father of 

Computer. 

Let's Know More 

IBM's first PC was introduced 

on August 12, 1981. 

The term 'PC' stands for 

'Personal Computer'; 

making IBM responsible for 

popularising the term PC'. 



'I 
PROCESS 

Connect the 
number. 

OUTPUT 

Talk to 
your friend. 
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Let us take another example: 

What do you do, when you want to talk to yourfriend on a telephone? 

Example 

 

E PARTS OF A COMPUTER 

A computer has four main parts, which help in performing the lPO cycle. 

KEYBOARD 

A keyboard is used to type data and instructions into the computer. The commonly used keyboard has 

104 keys, which can be divided into many groups based on theirfunctions. 

Figure 12:  Types of Keys 

Control Keys LI Function Keys L Typing (alphanumeric) Keys 

Navigation Keys 

 

fl  Numeric Keypad 

  

1. Typing Keys 
These keys include letters (Alphabet keys), numbers (Number keys), 
punctuation (. , : "), and special symbols (~ -; $ etc) keys. These keys also 

include the Shift, Caps Lock, Spacebar, Backspace, and Tab keys. 

2. Control Keys 

These keys are either used alone or in combination with the other keys to 

perform certain actions. Ctrl, Alt, Windows logo key, and the Esc key are the 

various examples of Control keys. 

Learning 
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2. Liquid Crystal Display (LCD) monitor:  They are monitors with flat screens that 

consume less power. 

3. Function Keys 
These keys are used to perform specific tasks. They are placed on the top row 

of the keyboard and are labelled as F1,..F12. These keys have different 

functions in different programs. 

4 N aviga IOfl 
These keys are used for moving through the documents and editing the text. 

These keys include the Arrow keys, Home, End, Page Up, Page Down, Delete, 

and lnsertkeys. 

5. Numeric 

Keypad 

The numeric keypad consists of number keys from 0 to 9, the arithmetic 

operators and the decimal point, similar to their appearance on a calculator. It 

is placed on the right side of the keyboard and used for entering numbers at a 

fast speed. 

MONITOR 

A monitor looks like a TV screen. It displays the work that we do on a computer. It also displays the 

results and movement of the mouse pointer on the screen. A monitor is also known as a Visual Display 

Unit (VDU). The information that we see on a monitor is called soft copy. There are three types of 

monitors. 

1. Cathode Rays Tube (CRT) monitor:  CRT monitors are big in size and consume 

more power. 

3. Light-Emitting Diode (LED) monitor:  These monitors have better display. 

They are thinner and lighter in weight. LED monitors use 40% less power than 

LCDs and last longer. These monitors are in maximum use nowadays. 

CENTRAL PROCESSING UNIT (CPU) 

It is the brain of a computer that processes all the instructions given to the 

computer. It does all the calculations and displays the result on the monitor. 

It also stores a lot of information. 

A CPU consists of three main parts. They are- MU, CU, and ALU. 

Learning 
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ThAIIapoptionhas enornFtted in 
the Windows 10 Anniversary Edition. Now, 

you can look for various applications 
directly by clicking the Start button. 
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Memory Unit (MU) 

In memory unit, we can store information or data according to our need. The information in the 

memory can be changed and recalled on the screen, whenever needed. The data and instructions are 

also stored in the memory unit, which are to be processed. 

Control Unit (CU) 

The control unit works like a traffic policeman. It controls and manages the working of all the parts of a 

computer. 

Arithmetic and Logical Unit (ALU) 

The ALU unit performs all the arithmetic calculations, like addition, subtraction, multiplication, and 

division. It also performs logical operations. 

MOUSE 

A mouse is a pointing device. It is connected to the CPU by a cable. A mouse 

usually has two buttons on it. It is used to point, select, and move any object on 

the screen. When we move a mouse with our hand, a pointer on the screen 

moves in the same direction. It also helps to draw pictures. Nowadays, the 

most commonly used mouse is the one that has a scroll wheel in the centre of 

the two buttons. 

)  )  For Better Concept Clarity 

> Click on Start> scroll down to Paint 3D to open Paint 3D program. 

> Select the Ovaltool in the 2D shapes menu. 

> Now, drag the pointer on the drawing area to draw the oval 

shape. 



WHAT MAKES A COMPUTER POWERFUL? 

Speed A computer works very fast and can do a large number of calculations quickly. 

Reliability Computers are quite reliable. They do not make any mistakes. 

Storage A computer can store a large amount of data, which can be used anytime. 

Versatility A computer can perform a variety of tasks and is used in almost all the fields. 

Acctracy A computer always gives correct results. Mistakes are normally done from a user's side. 

DiIignce A computer can work for long hours without getting tired. 

Multitasking A computer can do many things at the same time. 

DISADVANTAGES OF A COMPUTER 

A computer is a useful learningtool, but it has some disadvantages, too. Some of them are as follows: 

INTELLIGENCE QUOTIENT (ZERO IQ):  A computer does not have an IQ or its own 

intelligence. By mistake if you enter the incorrect input, it will give the wrong result. 

HEALTH Working on a computer for long hours can affect your eyesight. ) 

It can also become the cause of obesity in people. 

ELECTRICITY:  A computer depends on electricity and 
J cannotworkforalongtimewithoutit. 

 

COSTLY: It isa costly device. 

 

NOTE 

GIGO means Garbage In Garbage Out. It implies that if you enter wrong input, the computer will generate 

wrong output. 
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RECAP 

       

       

       

        

) Computer is a machine that works with data and instructions given by the user. It works on IPO 

cycle. 

> Input is the data and instructions that is entered into a computer. 

> A keyboard and mouse are used to enterdata and instructions into the computer. 

> A keyboard has a different sets of keys. They are-Typing keys, Control keys, Function keys, 

Navigation keys, and Numeric keypad. 

> A monitor displays all the work that we do on a computer and also showsthe output. 

> A CPU does all the calculations and displays the result on the monitor. 

> ACPUconsistsofMU,CU,andALU. 

> An ALU performs all arithmetic calculations and logical operations. A mouse is used to point, select, 

and move any object on the computer screen. 

> The output printed on a paper using a printeris called the hard copy. 

Learning 
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SECTION - A 

A. Fill in the blanks. 

1. Acomputerworkswith and  

2. A computer can a large amount of information. 

3. Akeyboard has keys. 

4. A is used to point, select, and move any object on the computer screen. 

5. The consists of number keys, arithmetic operators, and the decimal point. 

6. A does all the calculations and displays the result on the monitor. 

7. Amonitorisalsoknownasa  

8. A .. displays all the work that we do on a computer. 



I am not afraid of a cat, sit on a mat, 

have a long tail, can send e-mail. 
I 

I give output on a paper. 

Whatever you type and draw 

can be seen on me. 

I am a part of a CPU and do 

arithmetic calculations. 

Control all 

the activities of a computer. I 

r Mouse 

I Cu 

9. keys are used for moving through the documents. 

 

CPU Store Data Instructions Monitor 

VDU . 104 Navigation Numeric keypad Mouse 
HINTS 

 

B. State True or False. 

1. Acomputerhasan IQ. 

2. An output printed on paper is known as soft copy. 

3. A computer has four main parts. 

4. MU stands for Memory Utility. 

5. A CPU consists of AU and LU. 

6. The information that we see on a monitor is known as softcopy. 

7. Function keys are placed on the right side of the keyboard. 

C. Match the following. 

D. Application-based Questions. 

1. Mary is reading the soft copy of a letter. Which part of a computer is she 

using? 

2. Supriya wants to paint using a computer. Which computer device will you 

suggest her to use for making a colourful drawing? 

3. Saurabh wants to type a story using a computer. Which device should he 

use to do so? 

Learning 
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SECTION  -  B 

A. Multiple-choice questions. 

1. can be words, numbers, pictures, or sound. 

a. Data b. Processing c. Meaningful information 

2. A computer displays after processing the data. 

a. Input b. Process c. Output 

3. keys are used for moving through the documents or web pages. 

a. Control b. Function c. Navigation 

4. The monitor consumes the least amount of power. 

a. LCD b. CRT c. LED 

5.  keys are either used alone or in combination with the other keys to perform 

certain actions. 

B. 

a. Control b. Typing 

Write full form of the following. 

c. Navigation 

1. IPO 5. VDU 

2. Cu 6. MU  

3. CPU 7. IQ 

4. ALU 8. LCD  

C. Answer the following questions. 

1. What is a computer? 

2. How do you enter data and instructions into a computer? 

3. What do you call the information, that you enter into the computer? 



MY ACTIVITY Learning While Playing 

A. Find words from the word grid with the help of the given hints: 

4. Name the device that is known as the brain of a computer. 

5. List any two features of a computer. 

6. Mention any two disadvantages of a computer. 

7. How many types of keys are there on the keyboard? Name them. 

> A device used to type numbers, letters, or 

words 

> Information we get after processing 

) A unit that stores the information 

Thepartofacomputerthatprocessesallthe 

instructions 

> Theinformationthatweseeonamonitor 

D K P C A S Y Q  R P 0 M G 

KEYBOARDHNE S 

CARFIJLOUZGCKT 

T H 0 M E M 0 R V U N I T 

ORMOQNRXS F EAW 

UPERBILTWPKTY 

T U C F W T C N C E W A B 
PIPZMOEI JLRDU 

S UNXR STORAGE 

T B H F A S 0 F I C 0 P V 
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B. Write the missing Input, Processing and Output for the following machines by using the 

hints given below. 

MACHINE INPUT PROCESSING OUTPUT 

Microwave Rice and water Ready to eat 

Juicer Carrots, oranges 
Churning 

and 
extracting juice 

I Food 
Processor 

Cutting the 

vegetables 

Calculator 
Numbers and 

operating symbols 
Calculated 

answer 

______ 

Washing 
Machine 

Washing clothes Clean clothes 

Toaster Slices of bread Heating and grilling 

- 4: 

I I 

Music 
System 

Spinning 
Music 
and 

songs 

ttj 

- 

Water 
Purifier Plain water 

Clean 
drinking water 

HINTS  I Ready juice, Big pieces of vegetables, Calculation, Heating and cooking, Purifies water, Chopped 
I vegetables, Dirty clothes, Music CD, Toasted bread slices. 

Learning 
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1  Microsoft Word  by clicking on the  Start>  scroll down to  Word 2016. 

ge the given sentences according to the word  COMPUTER  and type them in MS Word. 

For example: 

1. C - Come with clean hands. 

2.  

3.  

4.  

5.  

6.  

7.  

8.  

your hand if you need help. 

nd drink outside the lab. 

the keyboard keys gently. 

tam silence. 

eta the lab in a queue. 

iyour teacher's instructions. 

your computer off before you leave. 

ievices carefully. 

To learn the mouse skills through activities, visit the website: 

ww.mouseprogram.com/practice.html  

To practice various keys, visit the website: 

ittp://www.learninggamesforkids.com/keyboarding_games.htrn!  

To learn more about the basic parts of a computer, visit the website: 

ittp://www.wartgames. corn/themes/tech/computerparts.html 

Using Creativity 

Make a COLOURFULCOLLAGE on Parts of a Computer  and label them. 

ONLINE LINKS Looking For More 

PROJECT WORK 

LAB SESSION LPerfection Through Practice 

Opet 

Arrai 

a 15 

Eat a 

P res 

M air 

Corn 

b 

Turn 

Use 

Divide the class into four groups and discuss the topic: 

How is the computer useful? 

For Concept Clarity 
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Computers with  Kips  



Trackball 
It has a ball on its top. To move the 
pointer on the screen, roll the ball 
with your finger. 

Light Pen 
Joystick 

It is used for playing games. It helps to 
move the items on the screen. 

Scanner 
A scanner copies a picture or text 
printed on a paper into the computer. 

INPUT DEVICES 

It looks like a pen that can be used on a 
special pad. Whatever you write on this 
pad can be seen on the monitor. 

Web Camera 
It is primarily used to share 
pictures and have live chat 
with our friends and 
relatives using the Internet. 

HARDWARE AND SOFTWARE 

LEARNING IN THIS CHAPTER 

r Hardware Software 

Students! By now you must have understood that a computer is an amazing machine that can do 

differenttypes of jobs. It has different parts thatworktogethertoform a computersystem. 

The two basic parts of a computer system are: 

HARDWARE SOFTWARE 

HARDWARE 

The physical parts of a computerthat you can touch and feel are called Hardware. 

A human body consists of different parts. The outer parts of a body are visible, but the parts, like brain, 

lungs, heart, etc., which are inside, cannot be seen. Similarly, in a computer, we can see the parts of the 

hardware that are outside, e.g., monitor, keyboard, etc. They are attached to the CPU by cables. Some 

parts of hardware are inside the CPU. You can see them only when you open the CPU box, e.g., hard 

disk, CPU chip, etc. 

The hardware of a computer is further classified into three parts—Input, Output, and Storage devices. 

IN PUT DEVICES 

There are special types of hardware devices that are used to input words, numbers, sound, or pictures 

into a computer. These are called Input devices, e.g., keyboard, mouse, joystick, microphone, etc. 

Microphone 

A microphone is used to give 
our voice and other sounds 
as input to the computer. 

Learning 
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Fact File 

Alan Turing is known for 
his contribution towards 
modern computers. He is 
considered as the Father 
of Modern computers. 

Pen Drive 

Fact File 

Lady Ada Lovelace is 

regarded as the first 

computer programmer. 

CD stands for Compact 
Disk. It is a round, flat, 

and shiny disk that 
stores a lot of 
information. 

It is a device that stores 
a huge amount of data 
and information. It is 

present inside the CPU 
box. 

It is very small in size, 
but can store and 

transfer a lot of data from 
one computer to another. 

Due to its small size, it 
can be handled easily. 

Learning Kips Computers with 

OUTPUT DEVICES 

The devices that display the information and results are called the Output 

devices, e.g., monitor, printer, etc. 

A monitor looks like a 
TV screen. Whatever 

you type on the 
keyboard can be seen 
on the monitor. It also 

displays the processed 
information. 

STORAGE DEVICES 

It prints the output that 
you see on the 

computer screen on 
paper. 

Speakers are used to 
hear music and sounds 
stored in a computer. 

The devices used for storing data are called Storage devices. Hard disk is the 

main storage device, which stores the entire work that we do on a computer. 

Some other important devices, like CD, Pen drive, and DVD are also used to 

store information. 

Software is that part of a computer, which cannot be touched. To make the 

hardware work, we need to have software in the system. 

Know the Fact 

intel 
Intel is the worlds 

largest processor-making 
company. 



Example  Similarly, an  Operating System  is the  DRIVER  of a computer, which 

makes it run. Without an Operating System, a computer cannot 

work. 

Learning 
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Let us understand software with the help of the following examples: 

Students! All of you must have seen and used a music system. The parts, like 

speakers, CD, and DVD, etc., which you can touch are hardware. Can you 

touch the songs or music recorded on a CD or DVD? No, because that is 

Software.
Figure 

Example  A CD is hardware, but the songs or movies stored in it are software, as they 
2.1: Music System 

cannot be touched. 

Likewise, a TV is hardware but the programmes that you watch on it are software. 

Let us go back to the working of a computer. Which of the following step is done by software? 

Figure 2.2: Working of a Computer 

Yes! Processing is done by software. It takes the input from the user, processes it, and displays the 

output on the monitor. 

Thus, we can define, software as a set of instructions given to the computer to do a particular work. 

There are two types of software: 

>  System Software >  Application Software 

SYSTEM SOFTWARE 

It is a set of programs that controls the overall working of a computer. 

Operating system  is a part of system software that makes a computer run. It manages all the input 

and output operations. It also manages the link between the different parts of a computer and the 

user. Let us understand the operating system with the help of an example. 

Let us take the example of a car. It has petrol, engine, and wheels. 

But, it is not moving. When will the car move? 

It will move only when the DRIVER starts it. 

So, the DRIVER is the OPERATOR of the car. 
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A Presentation Software  lets 
you create slides, charts, 

animation and video c11p5 in 
a lively manner. 
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A computer is a general purpose device that can be 

programmed to carry out a set of arithmetic or logical 

operations, automatically. Since a sequence of operations 

can be readily changed, the computer can solve more than 

one kind of problems. 

Microsoft Word 

Microsoft Disk Operating System (MS DOS), Windows XP, Windows 7, Windows 8, Windows 10, UNIX, 

LINUX, and Mac OS are the examples of some popular operating systems. 

Functions of Operating System 

> It controls the overall working of the Input and Output(l/O) devices. 

> It provides the login password to prevent the misuse of a computer. 

> It keeps a track of information regarding creation, deletion, transfer, and copying of files. 

> It helps to run the Application software, like Paint 3D, MS Word, Scratch, etc. 

> It allocates memory to various programs whenever required. 

APPLICATION SOFTWARE 

The software that helps you to do a specific type of work is called Application software. Let us 

understand this with the help of an example. 

What can you do with a juicer in your house? You can only extract juice of fruits and 

vegetables with it. It indicates that you can do only a specific type of job with this 

---, machine. 
Example 

There are different types of application software that help in doing specific types of jobs. Let us have a 

look at some of the application software: 

Word Processing Software:  A word processor helps you to create professional looking documents, 

quickly and efficiently. It provides many features to change the appearance of text in a desired 

manner. 

Examples: Microsoft Word, Word Pad, OpenOffice.org  Writer, etc. 

Presentation Software:  It lets you create slides, charts, animation, and video clips in a lively manner. 

Examples: Microsoft PowerPoint, OpenOffice.org  Impress, Adobe Flash, etc. 

Microsoft PowerPoint 
Learning ComK(P4 
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Paint 3D 

Spreadsheet:A  spreadsheet program helps you to perform calculations and display data in the form of 

a chartto analyse in a betterway. 

Examples: Microsoft Excel, Lotus 123, Openofflce.org  Caic, etc. 

Multimedia Software:  It is used to create videos, animations, sounds, graphics, and text with a high 

degree of interaction. 

Examples: Games software, Windows Media Player, Windows Movie Maker, etc. 

1 

2 

3 

4 

S 

6 

7 

8 

9 

x 

Lt Q.rt.,..3 Die, t_.. 

-- I - - - jCttttFt.m.*.q. 
-- 81 I- At $-%'M.tTg(i. Dd.t. 

A- C.it.w. 
clebu.4 . . MQnflfd Cit. 

A B C 0 E 

Students Performance Report 

ROLL NO NAME HINDI ENGLISH COMPUTER SSC 
101 PJAY 58 78 89 45 

102 VIJAY 78 67 78 56 

103 JAVA 76 56 78 54 
104 DIPTI 78 45 56 34 

105 SARIKA 98 56 76 65 
106  SIMRAN 67 76 87 54 

t2 

Microsoft Excel Games 

Graphics Software:This  software is used to create images, such as charts, graphs, photographs, logos, 

cartoons, and much more. 

Examples: Paint 3D, Photoshop, AutoCad, Dreamweaver, etc. 

Desktop Publishing Software:This  application helps you to combine both text and graphic features to 

design professional documents, like newsletters, books, magazines, etc. 

Examples: CorelDRAW, Adobe InDesign, QuarkXPress, etc. 

CoreIDRAW 
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The two basic parts of a computer are-Hardware and Software. 

The physical parts of a computerthat you can touch are called hardware. 

A set of instructions given to the computerto do a particularwork is called software. 

System software is a set of programs that controls the overall working of a computer. 

The software that is designed to do a specific type of work is called Application software. 

A. Fill in the blanks. 

1.  The parts of a computerthat can be touched are called  HINTS  I 
2.  The devices used for storing data are called devices. ' Software 

Hardware 
3.  

4.  

The devices that give results after processing are called devices. 

A set of instructions given to a computer to do a particular work is called 

Operating system 

a  Storage 

Output 

5.  The manages the overall working of a computer. 

B. State True or False. 

1. The software that can do a specific type of work is called System software. 

2. A scanner is an input device. 

3. The Paint 3D program is used for drawing pictures. 

4. A printer is an output device. 

5. The devices that give us output are called input devices. 

C. Application-based questions. 

1. Ayush wants to record a song in the computer. Which input device can he use? 

2. Sheena wants to draw a greeting card using a specific software. Which type of software will she use? 
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D. Match the following. 

                   

                   

     

Input device 

     

Printer 

   

                   

                   

           

( 
• Hard disk 

Songs 

o  90~85+69+98+76+84 

 

   

__-- 

Data 

      

            

Storage device 

 

            

 

Hardware 

 

                   

                   

Software • Keyboard 

SECTION  -  B 

A. Name the device used for each of the following jobs. 

1. A device commonly used for playing games 

2 A device used to store huge amount of data and information 

3. A device that can read words, pictures, or numbers from 

paper and store them in a computer 

4. A device that is used to hear sounds and music stored in a 
computer 

B. Answer the following questions. 

1. Define the term software. Name its types. 

2. What is a storage device? Give any one example. 

3. Which hardware devices are used to enter words, numbers, or pictures? 

4. Which application software is used fortyping and making corrections in the text? 

5. Name the program used for performing calculations. 



MY ACTIVITY Learning While Playing 
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2. 
5. 
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1. 

B. Name the devices and place them in correct columns. 

Storage Output Input 
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A. Complete the crossword puzzle using the hints given below. 

1. I am a part of a computer that cannot be touched  

2. I am a round, flat, and shiny diskthat is used to store a lot of information  

3. I am a part of the system software that makes a computer run  

4. I am used to share pictures and have live chat  

5. I look like a pen and am used to write on a special pad  

6. I am small in size and can transfer data from one computerto another  



Visit the following websites to perform activities on hardware devices: 

> www.i cts p ed a list, corn/jo-facts. ml 

> www. I cts p ecia list. corn/hard soft. html 

>  www.ictspecialist.com/peripherals.html  
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LAB SESSION Perfection Through Practice 

For Concept Clarity •UP DISCUSSION 

Conduct a group discussion on the topic: Input and output devices. 

Ask the students to support the discussion by giving real-life examples. 

>  Divide the class into four groups and discuss with them the topic, 

Types of Software. 

>  Make a list of hardware devices that you see in your computer lab. Classify them into Input, 

Output, and Storage devices. 

Make a list of differenttypes of application software and write about their usage in one line each. 

Open the Calculator software by selecting the Start> scroll down to Calculator. 

Solve the following: 

(i) 25*45 

(ii) 52/4 
S 

CS 

STANDARD 

v 

C 

M 

g 

0 
16 

~ 

(iii)  14*5 7 8 9 X 

4 5 6 - 

(iv)  582 - 287 1 2 3 + 

(v)  ± 789 + 649 0 = 

I  PROJECT WORK Using Creativity 

> Make a COLOURFUL chart or collage on the topic— Hardware Devices. 

> Draw any four hardware devices and write a few lines about them. 

ONLINE LINKS Looking For More 



0 

4 

Activity—i 

Open  GCompris educational  software. 

Select Top Menu >  Mathematics Share pieces of candy  $4'  activity. 

Drag and drop the characters on the screen. 

To divide the candies equally,drag and drop equal number of candies in the boxes. 

Click on Ok to check the result. 

Activity-2 

> From the Top menu select Land Safe  'I,°  activity. 

> The Tux Ship will move, use up and down cursor keys to control the thrust. 

> To control the direction of Tux's Ship use the right and left arrow key. 

> The landing platform turns green when the velocity is safe to land. 

> Make sure the Tux Ship lands on the landing platform safely. 
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Figure 3.1: Starting Tux Paint 

LEARNING IN THIS CHAPTER 

How to open Tux Paint? 

Pattern brush shapes 

Haze brush shapes  

Difference between Paint and Lines tool 

Stamp tool 

Magic tools 

• Rainbow effect 

Printing a drawing 

2' TUX PAINT 

Tux Paint is an amazing drawing program for students. Unlike other drawing/painting programs, Tux 

Paint has a lot of creative tools, funny animations, and magical effects, which make it one of the best 

drawing software available. 

Some of its unique features are: 

Tux Paint is a free software. 

>' Tux Paint has a drawing mascot, which helps you to learn more about it. 

> A large variety of tools help the students to create beautiful designs. 

We can add personalised stamps to our drawing. 

Funny sound effects are played when we selectanytool inTux Paint. 

> We can load and save images directly as thumbnails without using any file name in Tux Paint. 

HOW TO OPEN TUX PAINT? 

Select the Start button > Tux Paint > Tux Paint (Full Screen). 

When you open Tux Paint, it displays two modes: 

Windowed and Full screen. Selecting the Full Screen Mode will not 

display the Title bar. 

You can now see the welcome screen ofTux Paint. 

> After the welcome screen, you will get the opening screen of 

Tux Paint. 
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Colors Palette 

$  VINEBRUSH 

> Select the Paint tool , . Now, you 

II will see the Brushes sub-toolbox on 

the right hand side. Select the filled 

circle shape and choose brown 

colour from the palette. Draw the 

) trunkofatree. 

> Scroll down and select the Vine 

brush from the Brushes sub-tool Figure 3.4: Using Paint Brush Shapes 

 

Fact File 

  

   

 

Bill Kendrick 
The lead developer and 

,
esigner of Tux Paint. I 

    

    

    

 

You can add more colours 
by clicking on the last 
option of the Colors 

palette. After clicking it, 

you will get Pick a Color 
box on the screen. Select 
any colour of your choice 
and click the Back button 

to go back to the main 
screen and use the 

selected colour. 

  

First level 
brush size 

o 

f.v& 

t:1 
Haze brush 

Figure 3.2: Welcome Screen of Tux Paint Figure 3.3: First Window of Tux Paint 

PAINT BRUSH SHAPES 

Tux Paint gives us an option to draw beautiful patterns using the Paint 

tool , . Let us see how many beautiful patterns we can make. 

box. Now, select green colourfrom the Colors palette. 

> Move the pointer to the drawing area and draw the leaves by clicking on 

the trunk. You will see a beautiful tree as shown in Figure 3.4. 

> Similarly, select other brush shapes and see how many different patterns 

you can draw. 

HAZE BRUSH 

Haze brush is a unique sub-tool that produces a hazy appearance. 

We can use it to draw objects that are far away. 

Select the Paint tool L ,then choose the required colours to 

draw mountains, Sun, and river. 

Now, select the Haze brush and select light blue 

coour. Draw a few clouds in the sky. Similarly, select green 

colourand draw bushes as shown in Figure 3.5. 

Pkk *cotw ond. bn& tMp.todtow with. 

Figure 3.5: Using Haze Brush 
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Available Stamp 
options 
I 

Click on the Mirror 
option to get the 

Mirror image of your 
stamp. 

1h  i\ 

Adjust the size 
your stamp using 

L.  Slope bar.  - 

Figure 3.7:  Using the Mirror Option > Now, paste the selected stamp besides the previous stamp. 
Learning 
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1 DIFFERENCE BETWEEN PAINT AND LINES TOOL 

The Lines tool works in a way that is quite similar to the Paint tool. It has the same brush shapes in 

the sub-tool box. It is used to draw lines and patterns. The difference between the Lines tool and Paint 

tool is as follows: 

Paint Tool Lh- es Tool 

 

   

) While selecting the Paint tool, the pointer 

changes into a Paint brush shape. 

> Itisafree-hand drawingtool. 

> The selected brush type pattern is directly 

drawn on the canvas. 

)  When Lines  tool is selected, the pointer 

changes into cross hair(+) symbol. 

> It draws only in the form of straight line. 

> The pattern appears on canvas only after you 

complete the line and release the mouse 

button. 

STAMP TOOL 

  

It is an interesting tool, which you have already used in your previous class. This tool is used to add 

ready-made images as stamps. Tux Paint already has some inbuilt stamps. Additional stamps can be 

downloaded from the following website: www.tuxpaint.org/download/windows  

Further, select the link: tuxpaint-stamp-2009.06.28-win32-installer.exe 

On installing the stamps file, we can see various categories of stamps in the sub-toolbox. 

ClickontheStamptool intheToolsbar. 

Choose any one stamp from the Stamp sub-toolbox. To have 

more stamps, click either on the Left or Right arrow c. 

Select the Cock stamp. 

You can also increase and decrease the size of the stamp 

usingthe Slope bar  just above the Colors palette in the 

sub-toolbox. 

Figure 3.6: Using the Stamp Tool 

> Now, click on the canvas and the stamp will be pasted. 

Likewise, select the Hut stamp and paste it on the canvas. 

> We can also use the mirror image of the selected stamp by 

choosingthe Mirroroption  f'  below the right and left 

arrow keys in the sub-toolbox. 

> ClickontheMirrorbutton  fr. 



- 

5,0w LJa..iu  Mosaic Effect, 

I1,.n,. . I 
Click tow,r,ds the edyp of your pkturo to po11 window blinds over it. Move 
porperrdicsdurly to open or close the blinds. 

Figure 3.8: Using the Mosaic Effect 

MAGIC TOOLS 

In Tux Paint, there are various magic effects that allow 

you to draw wonderful patterns. Let us learn about 

some of the pattern effects in Magic tool. 

MOSAIC EFFECT 

The mosaic effect tool is used to apply a pattern of many 

small coloured pieces of stones on the canvas. 

Open a new canvas and draw a sunset scene or you 

can select any coloured background. 

Click the !iajc tool : and select the Mosaic effect on the Selector. 

Bring the magic wand to the canvas and click on it. 

The canvas will be filled with mosaic effect. Clicking it further will change its 

colour. 

KALEIDOSCOPE EFFECT 

This tool is used to create free-hand patterns. The most amazing feature of this 

tool is that even if we move the magic wand from a single point, it draws from 

all the four directions. Let us learn how to use it. 

Select the green background. 

Now, click on the Magic tool 

and select Kaleidoscope 

effect from the Selector. 

Pick yellow colour and bring 

the magic wand on the 

canvas. 
disk townsds the edge of yoos picture to poll window blinds over it. 140ve 
posrendicol.r,ly to open or close the blinds. 

Now, click and drag the - 

mouse as you wish. Figure 3.9:  Using the Kaleidoscope Effect 

A pattern will start appearing on the canvas. After designing the pattern, 

fill colour in it. 

Let's Know Morei 

Tux Paint supports vector 

graphics, which means that 

you can draw images that 

can be zoomed up to 100 

times their original size 

without compromising on 

the quality of the image. 

Let's Know More 

Fold Effect 

If you want to apply the 

fold effect on your 

drawing, use the Fold sub- 

tool of Magic tool. 

Let's Know More 

Rosette Effect 

This magic tool is used to 

draw a pattern in the 

shape of a rose. 

Let's Know More 

Ripples Effect 

Applying this magic tool 

makes an object look wavy 

in a circular pattern. 
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1K K ,nd dl.uJ thb fl10u*U o emboss tim piclula. 

There are 47 different 
background 

colours/pictures with 
which you can start a new 

drawing in Tux Paint. 

EMBOSS EFFECT 

This magic tool gives a raised 

effect to an object from the 

surface that you have drawn. 

> Select the Emboss effect 

f from the Selector. 

> Bring the magic wand over 

the image on the canvas and 

drag the mouse to emboss cIIcknddrth*meuo.mbouth.pKtur.. 

the image. 
Figure 3.10: Using the Emboss Effect 

> Observe the change in the image. 

E RAINBOW EFFECT 

In the sub tools of Magic tool, there are two types of Rainbow effect tools. 

RAINBOW EFFECT : It draws a trail of rainbow colours as you drag the 

magic wand on the drawing area. 

REAL RAINBOW It allows you to draw a rainbow just like the one you see 

in the sky after rainfall. 

Let us try both the effects on our drawing. 

> Select the Magic tool from the Tools bar and the Rainbow effect 

from the sub-toolbox. 

> Now, drag the magic wand 

from one point to another in 

an arc shape. 

) As you move the mouse, a trail 

of rainbow colours will be 

drawn. 

> Now, select the Real Rainbow 

effecte. 
Figure 3.11: Using Rainbow and Real 

> Choose a single point on the drawing area. Rainbow Effect 
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Know the Fact 

Tux Paint is translated in 
129 languages. 

Many Indians have 
participated actively in the 
translation process of Tux 
Paint into the languages of 

Indian origin. 

Ankit Malik - Hindi 

Ravishankar Ayyakkannu - 
Ta m II 

Kartik Mistry - Gujarati 

Pavithran Shakamusi - 
Telugu 

Let's Know More 

Noise effect is used to 
add grainy look to an 

image by adding random 
variations in the 

brightness or in the 
colour of an image. 
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Figurc tiP: Printing a Drawing 
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Click and dragthe wand from one end to the other. 

> Release the mouse and you will see a real rainbow on your canvas. 

You can add the other effects using Magic tools in the same way. 

PRINTING A DRAWING 

Tux Paint allows you to print your drawing on a paper. 

Open the drawing that you want to print. 

Selectthe Rrtnt tool intheJcois bar. 

A box appears on the screen. 

Click on Yes to print. 

You have learnt almost everything about the Tux Paint, and its 

various tools. Draw more pictures by applying new effects and 

ideas for better understanding of the tools. 

For Better Concept Clarity 

Let us draw a scenery on a new blank canvas. 

> Open a new file with green background. 

Select the Paint tool . Choose blue colour to draw the 

pond. Now, select the Magic tool and then choose Fill 

tool. Click on the pond to fill it with blue colour. 

Now, select the Grass effect and choose dark green 

colour. Draw some grass on the ground. 

Apply noise effect to the pond by using the Noise effect 

from the Magic sub- toolbox 

Now, choose the Flower tool and draw flowers of 

different colours. 

Select the Paint tool. Draw the trunk of trees and fill brown colour in them. Pick the Vine 

tool ' from the Brushes section. Draw the upper part of the tree as shown in the figure. 

Add cherries on the trees by using the Stamp tool 
Sp• 

Add two Gander birds by using the Stamp tool. 

Now, select the Starfish shape from the Brushes section of the  Paint  tool. 
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BRAI N 

> Tux Paint gives us an option to draw beautiful patterns using the Paint tool. 

> Haze brush is a unique sub-tool that produces a hazy appearance. 

> Stamp tool is used to add ready-made images as stamps. 

> The Mosaic tool is used to apply a pattern of many small coloured pieces of stones on the canvas. 

>. Kaleidoscope tool is used to createfree-hand patterns. 

> Emboss tool gives a raised effectto an objectfrom the surface thatyou have drawn. 

SECTION - A 

A. Fiflintheblanks. 

1 The is used to draw free-hand drawings. 

2. We can create a mirror image of a stamp usingthe button. 

3. tool gives the raised effect to an object from the surface that you have drawn. 

4. Tux Paint has been translated in languages. 

5. The tool is used to apply a pattern of many small coloured pieces of stones. 

HINTS 

   

 

Emboss 129 Mosaic Paint Mirror 

  

B. State True or False. 

1. Tux Paint is a free software. 

2. When you select the Lines tool, the pointer changes into brush shape. 

3. Stamp tool is used to add ready-made images as stamps. 

4. Mosaic effect lightens the colour of an object. 

5. Tux Paint provides 48 different background colours or pictures. 
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SECTION  -  B 

A. Multiple-choice questions. 

1.  brush is used to draw objects that are faraway. 

a.Vine b.Haze c.Emboss 

2. is the lead developer and designer of Tux Paint. 

a. Mark Zuckerberg b. Bill Kendrick c. Bill Gates 

3. Which of the following tools is used to create free-hand patterns? 

a. Kaleidoscope b. Emboss c. Drip 

4. When Lines tool is selected, the pointer changes into  symbol. 

a.* b.+ 

5. The  draws a trail of rainbow colours as you drag the magic wand on the 

drawing area. 

a. Mosaic effect b. Rainbow effect c. Real rainbow 

B. Answer the following questions. 

1. List any two features of Tux Paint. 

2. Explain the use of Mosaic effect. 

3. What is the use of Magic tool? 

4. Differentiate between Rainbow and Real Rainbow effects. 

5. How is the Stamp tool useful? 

Learning lW's Computers with  



Kaleidoscope effect 

Mosaic effect 

Magic tool 

Paint tool 

Emboss effect 

Lines tool 

C. Match the following. 

tool Waves effect Gras5 efect Noise 
eñcect jneS tool tool Stamp too/ 

I 2 

MY ACTIVITY Learning While Playing -p 

Draw these beautiful drawings using the given tools. 

 

4 

4 

+ 

4 

4 

4 

 

GROUP DISCUSSION For Concept Clarity 

Discuss the given topics with the students: Mosaic effect vs Emboss effect. 

ONLINE LINK 

 

Looking For More 

  

To learn more about magic effect tools, visit: http://tuxpaint.org/features  

Learning 
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LERV*G IN THIS CHAPTER  H 
P  Features of Windows 10 
P  Windows Taskbar 
P  Selecting and deselecting Icon, Opening 

a Program 

Figure 4.1: Windows 10 Desktop 

UNDERSTANDING WINDOWS 10 

F  Arranging and Sorting the desktop Icons 
Changing the desktop background and Screensaver 
Mouse Pointer shapes 
Shutting down your computer 

Tell me students, who takes care of all the household work at your home? Yes! You guessed it right. 

Your parents! They look after all the household work in such a manner that you do not have to worry 

about anything. It is because they run the house with a system. Imagine if your parents go away for 

sometime and you have to manage the house, what will you do? You will surely find it difficult to 

manage the daily chores of the house. 

In the same way, a computer has a special set of 

programs, which manages all the jobs of a 

computer and makes it run. This is known as the 

Operating System. 

Windows is an operating system. Without it, we 

cannot even start a computer or work on it. 

Now again, tell me students, when we use the 

word "window", which image comes to your mind? 

Yes! It is the glass window thrGugh which we can 

peep outside and see various things. Likewise, in 

computers, Windows is a program that shows 

different programs on the screen. 

FEATURES OF WINDOWS 10 

> Windows lOis more attractive, with a complete set of new pictures, themes, and icons. 

The best features of both Windows 7 and Windows 8 have been included in Windows 10. 

It has an improved Search tool - Cortana, which helps you to find information on your system or on 

the web directly. You can even give voice commands to this Search tool. 

It has a new 'Task View' button to the right of the search box, on the taskbar. This button provides 

the ability to open multiple desktops at the same time. 

> Windows 10 provides a Windows Store application where you can get a lot of free apps, games, and 

songs. 
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Fact File 

William (Bill) H. Gates 

He is the founder of 

Microsoft corporation; 

the worlds leading 

ftware company. I 

Let's Know More 

The Start menu can also 

be opened by pressing 
Windows key on the 

keyboard. 

Quick View 

Press Windows logo + D 

key combination to 

minimise all the open 

windows. 
I 

When we switch on a computer, Windows starts automatically. The first 
screen that appears with labelled pictures on it, is called Desktop. 

ICON S 

The small labelled pictures or symbols present on the desktop are called 
Icons. These icons are used to open specific programs or documents. 

Let us understand the concept of icons and desktop with the help of an 
example. 

40 

Quick View 

You can also activate Task 

View by pressing the 

Windows logo key + Tab 

key on your keyboard. 

When you goto the kitchen and open a cupboard, you find various labelled 

boxes, containing different items. The cupboard works like Windows and 

the labelled boxes work like icons. 
Example 

WINDOWS TASKBAR 

The Taskbar is a long horizontal bar located at the bottom of the desktop. It is 

divided into the following sections: 

THE START BUTTON 

The Start button is present at the bottom left corner of the 
U. 

Taskbar. When you click on the Start button, a list of options 

appears. This list is called the Start menu. 

You can use the Start button to perform common tasks, such as starting a 

program, searching files and folders, shutting down the computer, and much 

more. 

You can find File Explorer, Settings, and a list of the most used apps on the left 

side of the Start menu. 

MIDDLE SECTION 

The middle section of the bar shows the opened programs as buttons. Here 

you can add commonly used programs, such as the Internet Explorer, Word 

program, Windows media player, etc. They can be opened with a single click. 

When a program is active, its icon is highlighted in a lighter shade with a bar 

below it. 

NOTIFICATION AREA 

The right side of the taskbar is known as the Notification Area, which includes 

a clock and a group of icons that tell the status and notifications about the 

programs running on a computer. For example, software updates, network 

connectivity, battery, volume, etc. 
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Figure 4.3:  Moving the Taskbar 

Th.,.. T.k V.,.. 

¶Jw. It., d,.ltop 

Lockthebv 

Figure 4.4: Locking the Taskbar 

Peek Button Start Button Task View Button 

5/2/7016 

SELECTING AN ICON 

> To select any icon, simply click on it. 

> It will be highlighted. 

DESELECTING AN ICON 

> To deselect the icon, click away from the icon. 

> The icon will now be displayed in its original 

form. 

The Peek button is present on the extreme right of the taskbar. Click this button to minimise all the 

open program windows and view the desktop. 

Figure 4.2: Taskbar 

   

{Notification Area 

    

MOVING THE TASKBAR 

The Taskbar can be moved to any of the four sides of 

the Desktop. 

To move the Taskbar, take the following steps: 

Place the pointer on the blank area of the Taskbar. 

Press and hold the left mouse button, and drag 

the taskbarto any side of the desktop. 

Now, release the mouse button. 

LOCKING THE TASKBAR 

You can lock the Taskbar, that means it will not move to any place until you unlock it. 

> Right-click on the blank area of the Taskbar. 

Click on the Lock the taskbar option in the Shortcut menu. 

> You will notice that the taskbar will not move from its location. 

SELECTING AND DESELECTING ICON 
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View Large icons 

So,t by > I a Medium icons 

Refresh Small icons 

Paste Auto arrange iconl 

Pacteshortcut ./ Aligniconstogrid 

New > / Show desktop icons 

Display settings 

Personalize 

SELECTING ADJACENT AND NON ADJACENT ITEMS 

SELECTING ADJACENT ITEMS 
> Left-click on the first item to be selected. 

> Hold down the Shift key and click on the last 

item to be selected. 

> Release the Shift key. All the adjacent items 

will be selected. 

SELECTING NON ADJACENT ITEMS 
Hold down the Control (Ctrl) key. 

> Click on each of the items to be selected ,one-

by-one. 

> In this way, you will be able to select the non-

adjacent items. 

OPENING A PROGRAM 

> Click the icon, which you want to select and press the Enter key. The application window will open. 

Or 

Double-clickthe left mouse button on the icon to open it. 

ARRANGING THE DESKTOP ICONS 

As you arrange your study desk to make it tidy, similarly, you can arrange the icons on the desktop to 

give it a better look. To do this: 

> Right-click on the blank area of the desktop. 

> You will find a list of options. 

> SelecttheViewoption. 

> Click the Auto arrange icons option from the sub 

menu. 

> Observethechanges. 

Figure 4.5:  Arranging the Icons 

SORTING THE ICONS 

Sorting the desktop items means arranging them in a 

proper order. 

> Right-clickontheblankareaofthedesktop. 

> A Shortcut menu will appear. 

> Point to the Sort by option and click the Size sub-

option. 

> The icons will be arranged in the increasing order of 

the file size. Figure 4.6: Sorting the Icons 
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Figure 4.8: Changing Wallpaper 

Preview 
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CHANGING THE DESKTOP BACKGROUND 

You can change the appearance of the desktop background according to your choice in the following 

way: 

> Right-click on the blank area of the desktop. 

> You will find the list of options. This is called 

Shortcut menu. 

> Select the Personalize option. 

> The PERSONALIZATION window will appear. 

> By default the Background option is selected and 

preview of the current background is displayed in 

the right pane. Figure 4.7: Changing Desktop Background 

> Click on the drop-down arrow of the Background list box and select any option (Picture, Solid 

Colour, Slideshow)from the displayed list. 

> Select any picture from the 'Choose your picture' 

section or click on the Browse button to get more 

options forthe pictures from your computer. 

> Select any layout for the background from the 

Choose a fit list box. 

> A preview of the selected background will 

appear in 'Preview' section. 

> The selected picture will be set as the desktop 

background. 

CHANGING THE SCREEN SAVER 

The Screen Saver is an image, which pops up on the computer screen whenever a computer is left idle 

for a certain period of time. By pressing any key or moving the mouse, you can again get back to the 

normal screen. Follow the given steps to change the screen saver: 

> Right-click in the blank area of the desktop. 

> Click on the Personalize option from the Shortcut menu. 
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Figure 4.9: Changing Screen Saver 

You can even get to the Screen Saver Settings directly by typing 'Screen 

Saver' in the search box placed on the taskbar. Select the Change screen saver 

from the displayed options, the Screen Saver Settings dialog box will open. 

BUSY 

It means that computer is busy and 

wants you to wait. 

DOUBLE-HEADED ARROW 

This arrow is for resizing the window or 
pictures. 

NORMAL 

This arrow is for pointing, selecting, and 

draggingthe items on the screen. 

 FOUR-HEADED ARROW 
A 

4 This arrow is for moving pictures and 

 too lb a rs. 

k 

I BEAM 

This icon is for inserting the text in a 
document. 

WORKING IN BACKGROUND 

It means thatthe computeris processing 
while you are working. 

I 

The PERSONALIZATION window will appear. 

Select the Lock screen option from the left pane. 

Select Screen saver settings option from the right pane. 

The Screen Saver Settings dialog box will appear. 

Click on the drop-down arrow in the Screen saver section 

and select any screen saver of your choice. 

A mini preview of the screen saver will be displayed in the 

Preview box. 

To watch the preview on full screen, click the Preview tab. 

You will get the preview of the selected screen saver on the 

full screen. 

Move the mouse to get back to the Screen Saver Settings window. 

Set the time in Wait box as per your need. Use the up arrow to increase the 

time and the down arrow to decrease. 

Click OK. 

Know the Fact 

When a computer is 

switched on, Windows 

take a few seconds to 

load an Operating System. 

This process of loading 

the OS is called Booting. 

MOUSE POINTER SHAPES 

The shape of the mouse pointer changes according to the actions we perform. 
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SHUT DOWN YOUR COMPUTER 

Shutting down means, turning offa computer. To shut down 

your system, follow the given steps: 

Click on the Start button 0. 
Now,clickonthePowerbutton 

Select the Shutdown option. 

> The system will take a few seconds to shut down. 

Select the 
Shut down option 

Figure 4.10: Shutting Down a Computer 

> Windows is an operating system that controls and manages the functions of a computer. 

> The small labelled pictures on the desktop are known as icons. 

> The Start button is used to perform common tasks, such as starting a program, searching files and 

folders, and much more. 

> Notification Area is present on the right side of the taskbar. It includes a clock and a group of icons. 

> Double-clickingthe left mouse button on the icon opens the selected item. 

> Screen Saver is an image, which pops up on the screen, whenever a computer remains idle for a short 

time. 

SECTION - A 

A. Fill in the blanks. 

1. The is the first screen of Windows, which appears when the computer is switched on. 

2. application provides paid and free games, apps and songs. 

3. The is a long horizontal bar at the bottom of the desktop. 

4. TherightsideoftheTaskbarcontainsthe  

5. button provides the ability to open multiple desktops at the same time. 

6. The advanced search tool of Windows 10is called  

    

Desktop Taskbar Task View 

Windows Store 

  

Notification Area 

Cortana 

 

HINTS 
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B. State True or False. 

1. The clock is present on the left side of the Taskbar. 

2. The start button is found on the left side oftheTaskbar. 

3. When a program is active, its icon is highlighted in a brighter shade with a bar below it. 

4. Peek button is present on the left side of the taskbar. 

5. To change the desktop background, right-click on the blank area of the desktop. 

C. Application-based questions. 

1. Adarsh wants to arrange all the icons on the desktop in alphabetical order. Suggest him the way 

to do so. 

2. Karan is working on many applications on his computer. By mistake, he has clicked somewhere on the 

taskbar and all the open windows have minimised. Which button has Karan clicked on? 

SECTION - B 

A. Multiple-choice questions. 

1. Which program manages all the jobs of a computer? 

a. Operating System b. Desktop c. Screen Saver 

2. To arrange the icons on the desktop,  click on the blank area. 

a. Left b. Right c. Double 

3. Pressing Windows key + D combination,  all the open windows. 

a. Maximizes b. Closes c. Minimizes 

4. To open the Start menu, press the key. 

a. Ctrl b. Windows c. Alt 

B. Name the mouse pointers, which perform the following actions. 

1. For pointing, selecting, and dragging an item. 

2. For resizingthe pictures. 

3. It indicates that you have to wait because the computer is busy. 

4. Formovingpicturesandtoolbars. 
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C. Answer in one word. 

1. Name the term used for the process of loading operating system. 

2. Name the box that displays the preview of the Screen Saver. 

3. Name the option that displays all the apps and programs in the computer. 

4. Write the shortcut key combination to activate Task View. 

D. Answer the following questions. 

1. Define the term Windows. 

2. What is Desktop? 

3. What is a Taskbar? 

4. Write any two features of Windows 10. 

5. Briefly explain the use of Start button. 

6. Describe the term Screen Saver. 
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L MY ACTIVITY 

LAB SESSION Perfection Through Practice 

Learning 
Computers with  Kips 

A. Selecting and Arranging Icons. 

> Click on the This PC icon on the desktop. The icon will be selected and highlighted. 

> Now, double-clickthe icon. This PCfolderwill open. 

> Click the Documents option on the left side pane. This will open the Documents folder. 

> Select the adjacent folders by clicking the first icon to be selected then hold down the Shift key and 

click on the last icon. 

> Click the mouse anywhere on the blank area to deselect the items. 

Learning While Playing 

Fill in the crossword with the help of the given clues. 

iiiiii 

iiii 
• • 

Dclii. 

T A 

5 -U...-.. U__u.... G 8. 

.5 T 

DOWN 

1. The slant arrow that is controlled by the movement of the mouse  

4. The keythat helps in selecting non-adjacent items. 

6.  are the labelled pictures on 

the screen. 

8. The  button gives quick access to 

documents, windows applications, etc. 

ACROSS 

2.  clicking the left mouse button on 

the icon will open the application window. 

3. We can give voice commands to to 

search for a file. 

5. the icons means arranging them 

in a proper sequence. 

7. The key that helps in selecting adjacent items 



For Concept Clarity GROUP DISCUSSION 

Using Creativity PROJECT WORK 

> Discuss the features of  Cortana. 

> Differentiate between the functions of Task View button and Peek button. 

1 

Make an informative chart displaying all the  Versions of Windows  and their 
features. 

Looking For More 

To practice the mouse skills, visitthe website:  www.web-esl.com/pages/comp.html  

ONLINE LINK 

Learning 
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> Select the non-adjacentfolders by holding down the Ctrl key and clicking each of the desired icons. 

> Clickthe Close button. This PCfolderwill be closed. 

> Now, arrange icons on your desktop in different ways, such as Name, Size, and Item type. 

B. Changing Background and Screen Saver. 

> Right-click on the blank area of the desktop. A Shortcut menu will appear. 

> Select Personalize option from the menu. 

> Click the Background option. 

> Select any background from the displayed list and click on the Lock screen option. 

> Select Screen Saver Settings option from the right pane. 

> Click the drop-down arrow of the Screen saver list box. Set the screen saver to 3D Text and set the 

wait time to 2 minutes. 

> Click the Settings tab. In the dialog box, select Custom Text radio button and type KIPS and then 

click OK. Now again click OK and observe the change. 



 WORKSHEET 

A. 

1.  

Fill in the blanks. 

The data and instructions 

1-4 -I Chapters - 

entered into a computer using a keyboard or a mouse is called 

2.   is a long horizontal bar at the bottom of the desktop. 

3.  A  isusedtorecordourvoice. 

4.  The  

period of time. 

is an image, which pops up whenever a computer is left idle for a certain 

5.  While selectingthe tool, the pointer changes into cross hair symbol. 

HINTS Microphone Input Lines Taskbar Screen Saver 

B. State True or False. 

1. To change the desktop background, left click on the blank area of the desktop. 

2. CRT and LCD are the types of printers. 

3. A computerdoes not have an lQ or its own intelligence. 

4. Operating system is a part of Application software. 

5. To select an icon, simply click on it. 

C. Identify the shapes and write the names of the different mouse pointers. 

I 

'P 
D. Match the following effects with the correct icons. 

Stamp TooT 

Real Rainbow Effect 

Emboss Effect 

Kaleidoscope Effect 

Haze Brush 
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A. 

1.  

2.  

Chapters 1-4 

Choose the best answer. 

controls all parts ofacomputersystem. 

a.MU b.CU 

The process of loadingthe OS is called  

a. Backup b. Rooting 

c.ALU 

c. Booting 

3.  Nhich part of the computer cannot be touched or seen? 

.Hardware b.Software c. Storagedevices 

4.  Which tool is selected by default, when we open Tux Paint? 

a. Paint Tool b. Lines Tool c. stamp Tool 

5.  is present to the right side of the taskbar. 

a. Start button b. Desktop c. Notification Area 

B. Answer in one word. 

1.  Name a place where computers are used. 

2.  How many different background colours are available in Tux Paint?  

3.  Which part of a computer is known as Visual Display Unit? 

4.  Name the tool that is used to draw straight patterns in Tux Paint. 

5.  Which software helps you to do a specific type of work? 

C. Answerthefollowingquestions. 

1. Definetheterm Windows. 

2. What is a Desktop? 

3. Name some storage devices. 

4. Which effect is used to create free-hand patterns? 

5. What do you understand by the term IPO? 
4- 
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EDITING TEXT IN MS WORD 2016 

LEARNING IN THIS CHAPTER 

r  Starting Word 2016 • Moving, Copying, and Deleting the text 
• Entering, Selecting, and Editing the text • Using Undo and Redo commands 
r  Inserting the text • Using Spellings and Grammar, and Thesaurus 

Word 2016 is an application software used for Word processing. It was introduced by Microsoft 

Corporation, one of the world's largest companies in software development. Word 2016 has the power 

and flexibility to: 

Produce letters, reports, notices, newsletters, books, bills etc., quickly and in a presentable 

manner. 

Modify the text, both while typing and after typing. Beautify the text using colour, style, font size, 

border, shading, and various other effects. 

Insert graphics and make use of various drawing tools to draw pictures. 

Copy and move the text from one location to another. 

Share documents on the internet and invite people to view and edit documents which are 

shareable. 

Preview the text before printing it. Take multiple printouts. 

STARTING WORD 2011 

Click on Start lI Word 2016 

New 

The Start Screen of Word 2016 appears, known as 

the Backstage view. The Backstage view is the 

central location for managing the Word 

documents. In Backstage view you can create 

new, save, open, print, share documents, and so 

on. To create a new document from this location, 

click on the Blank document thumbnail. 

Word will open a new blank document with a 

temporary name, Documenti. 

- - -.-, ,- - 

Aa 

Blank document 1 
tour 

t.'_ 

1ite TIRE 

FIgure 5.1: Backstage View of Word 2016 
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Cursor 

  

   

Status bar 

, 

Figure 5.2: Word 2016 Document Window 

Creating a New Document 

Lascc. MCt. - 

Isv -a.-.- 

- - 

Select the 
New o.tion 

p 

—"a— — — — — _ta 5— 

Click on the 
Blank document 

click on the New button  I1  on the Quick Access 
Toolbar or press the shortcut key Ctrl + N. 

Saving a Document 

1 • '-'C. ..'*.0.....'.-5 

'.. 

-5 "a0.d 

IU C.- 
C.ma'. OP.S• Tr..yfl.. ,,..v20u,_I) S 5* Spa,  

-' t, PC 

• 

Select the 
Save o.tion U 

Enter 
L.O.CI File name 

k5557p•- W.d0.0..5 

LV3S .a.pa, 
)dI?FS)Ib0IIvA 5* SPa 
•*,IWZ%' PU PMI.sd. 
*SsOl4ItPM •. SPa 
•O/IW.05) 5.536 - 5* had.. 
I'W1dIbS4dM 5* —, 

p-------- 
Click on the 
Save button  

-  : - I-- 

0.5, 
J M 0.5. sa 

-S 

Click on the Save button I on the Quick Access 
Toolbar or press the shortcut key Ctrl + S. 

The small blinking vertical line that 

you notice on the screen is known as 

the Cursor. It is the insertion point 

and indicates the position where the 

next typed character will appear. 

(5 D,.....,wM1 W.d 

UM.q v.-. 
Minimize 

button 
Z - A TiUebarJ AaStCcO £aO. 

File tab Close 
button Quick Access 

A. I------ 

Toolbar 
P.— 

Ribbon 
Maximize 

button 

As you start typing, the cursor 

automatically shifts to the right. We 

can enter text on the same screen or 

create a new document. 

E ENTEkI ti.TEX1 

While typing in a Word document, you will observe that Word wraps the text automatically. Wrapping 

the text means that if the text does not fit in the current line then Word shifts it to the next line by 

default. Type the following text and observe the wrap effect: 

Learning is like eating food. It is not how much you eat that matters. What counts is how much you digest. 

The beautiful thing about learning is that no one can take it away. 

Before proceeding further, let us have a quick glimpse of how to create, save, open, close, and print 

a document in Word 2016, which we have already discussed in the previous class. 

- 

Figure 5.3: Creating a New Document Figure 5.4: Saving a Document 
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Figure 5.5: Closing a Document 

x 

N., Vt2d. 

C.'*II..,. - 

Enter 
File name Click on the) 

enbufloJ 

-'C. - p 

0 

, UDI 

Click on the Open button on the Quick Access 

Toolbar or press the shortcut key Ctrl + 0. 

Figure 5.6: Opening a Document 

WORD 2013 

Figure 5.7:  Printing a Document 

E> SELECTING AND FT!TFTEXT 

After typing the text in a document, you may want to make some changes in the text. Making changes 

in a document is called Editing. 

Before performing any action, like copying, moving, finding and replacing, deleting, or formatting the 

P 

d 

Closing a Document 

A ' "-.- .- 
-I. 

-------,. ..-_ 

(•__  
Info 

- 

Select the 
Close option 

Press Ctrl + W to close the document. 

Print 
e 

Select the 
Print option  

Printing a Document 

Click on the 
File tab . 

• , • S  .,. . • L'— ,n. 

Click on the Print Preview and Print button on the 

Quick Access Toolbar or press the shortcut key Ctrl + P. 

In Word 2013, you can also create a new document, 

save it, close it, open an existing document, print 
the document either by clicking on the Quick 

Access Toolbar or by selecting the New, Save, 

Close, Open and Print options from the FILE tab 
respectively. 

-J 



Click anywhere in the selection area while holding down the Ctrl + A key or triple-

click in the Selection area. 
Entire document 

text, we need to select the text. The selected text is 

displayed on the screen in a highlighted bar. 

To select a block of text, we can use the 'Selection 

Area', which is the blank area in the left margin of 

the document. We can select the text in a variety of 

ways. 

1l )O 

'U--"... H.d.ngL. 

Fool . $3,131 

I 
After typing the text in a document, you may want to make Text 

some changes in the text. Making changes in a document is called Editing. 

Selected 

II' 3 0313,303d3 £9 . - I 

Figure 5.8: Displaying the Selection Area 

SELECTING THE TEXT USING MOUSE 

Text to Select, Method 

A word Double-click on the word. 

A sentence Hold down the Ctrl key and click anywhere on the sentence. 

A paragraph Triple-click anywhere in the paragraph, or double-click in the left margin of the 
paragraph. 

  

A large block Click at the beginning of the text. Press the Shift key and without releasing it, click at 

of text the end of the text. 

SELECTING THE TEXT USING KEYBOARD 

You can select the text on a document by using the following Shortcut keys: 

Text to Select Shortcut Key 

One character to the left Shift+ E_ 

  

One character to the right Shift~ - 

  

One line up Shift + '1' 

  

One line down Shift+ 4' 

  

Beginning of the current line Shift + Home 

End of the current line Shift + End 

   

Beginning of the current document 

End of the current document 

WORD 2013  

Shift + Ctrl + Home 

Shift + Ctrl + End 

L
The above given methods and shortcut keys can also be used to select the text in Word 2013. 
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Cursorj 

Knowledge is nformation. It becomes powerful only when 

it is acted upon. Knowledge comes from learning. It Is of no 

AC AaBbC4 
4k.d.q1 

- '-"—--put it into practice. 

Overtype mode 
is selected 

Replaced 
txtj ..... I  

Knowledge is power. It becomes powerful only when 

it is acted upon. Knowledge comes from learning. It is of no 

value unless you put it into practice. 

Pfl. 4.14 M ..woc 

Figure 5.10: Overtype Mode is Selected 

INSERflNGTHETEXT 

Word 2016 allows the userto add new text to an already existing document in two different ways: 

By using Insert Mode 

By using Overtype Mode 

INSERT MODE 

) To select the insert mode, right-click on 

the Status bar. The Customize 

Status Bar menu appears. 

> Click on the Overtype option. The Insert 

option appears on the Status bar which 

shows thatthe Insert mode is selected. value unless you put it into practice. 

Insert mode 

Now to enter the text, place the pointer is selected 

to the right of the character where you  

want to insert new text. 

Type the new text and observe the 

change. Figure 5.9: Insert Mode is Selected 

Knowledge Is Information.jknowledge comes from learning. It Is of no 
I'  

Text added  

Knowledge is information. It becomes powerful only when 

it is acted upon. Knowledge comes from learning. It is of no 

value unless you put it into practice. 

OVERTYPE MODE 

You can replace the existing text by 

typing the new text on it. To enable 

the Overtype mode: 

> Click on the Insert option on the 

Status bar. It will change the 

existing mode into Overtype 

mode. 

>4  Now place the cursor before the 

letter and start typing. 

> The existing text will be replaced 

with the new one. 

WORD 2013 

n the same way you can add new text in an existing text in Word 2013 by selecting the INSERT or OVERTYPE 

options on the Status bar. 
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NoS 

Cut 
button 

Knowledge is Power. 

Information is Liberat ' 
twA 'Sn 

Information is Liberating 

Knowledge is Power. 

Text is 
moved 

Figure 5.11: Moving Text 

Paste 
button 

Let's Know More 

Tell me what you 

want to do 

It is a new feature, which 

can be used to get quick 

help on topics that you are 

looking for or the 

commands that you want 

to use in your document. 

Know the Fact 

Clipboard is a temporary 

storage area in Windows 

that allows you to store, 

cut, copy, and paste data 

while switching between 

the applications. Upto 24 

multiple text and graphical 

items could stay on the 

Office clipboard until you 

exit Office applications. 

After exiting the Office 

applications, the last item 

that you copied stays back 

in the Clipboard. 

Quick View 

To create a shortcut of 

Word 2016, drag its icon to 

the Desktop. 

MOVING THE 

This feature is used to move the text from its original location to a new 

location. 

Select the text you want to move. Click on the Cut button in the 

Clipboard group on the Home tab or press Ctrl +X. 

The text disappears from the document and is temporarily placed on the 

clipboard. 

Position the cursor at the location where you want to place the selected 

text. 

Click on the Paste button or press Ctrl + V. The selected text appears at 

the desired location as shown in Figure 5.1 1. 

WORD 2013 

In Word 2013 Cut, Copy and Paste buttons are present in the Clipboard group on 
the HOME tab. 

Copy and Paste options are used to duplicate the text. We can copy the text 

not only from one location to another within a document, but also from one 

document to another. This feature helps in reducing our time and effort in 

typing. The only difference between Copy/Paste and Cut/Paste features is 

that the Copy feature copies the text but does not remove the text from its 

original place as the Cutfeature does. 

Let's Know More  J 
Ribbon Display Options 
button present next to 

the Sign in button. When 

you click on this button it 
reveals the following three 

options: 

> Auto-hide Ribbon 

> Show Tabs 

Showlabsand 

Commands 
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UNDO 

REDO 

Knowledge is information. It becomes 

powerful only when It Is acted upon. 
Knowledge comes from learning. It is of 
novalue unlessyou put it into practice. 

Knowledge is information. Knowledge 
comes from learning. It is of no value 
unless you put it into practice. 

Click on the Undo  button. The Click on the Redo button. The 

4 deleted text re-appears on 4 deleted text again disappears 
the screen. from the screen. 

DELEFINGTHETEXT 

Word 201 6 provides the facility to erase the text. Follow these steps: 

D 
Select the text Press the Delete key The selected text will be removed 

You can also delete text by using the Backspace key. It removes the character to the left of the cursor 

position. To delete a block of the text, select the text and then press either the Delete key or the 

Backspace key. 

USING UNDO AND REDO COMMANDS 

Word 2016 keeps track of all the changes that we make in a document. We can easily undo any change 

and restore the original text. 

This option reverses the effect of the last command. To reverse one or more than one action, click 

on the Undo button present on the Quick Access Toolbar. 

To reverse the action of the Undo corrimand, click on the Redo button present on the Quick 

Access Toolbar. 

Knowledge is information. It becomes 
powerful only when it is acted upon. 
Knowledge comes from learning. It is of 
no value unless you put it into practice. 

Deleting the text .lt becomes 
upon in the original text.  4 

Knowledge is information. Knowledge 
comes from learning. It is of no value 
unless you put it into practice. 

After the delete action. 

Figure 5.12: Use of Undo and Redo Buttons 

WORD 2013 

L Similarly, in Word 2013, you can find the Undo and Redo options on the Quick Access Toolbar. 

CHECKING SPELLINGS AND GRAMMAR 

Word 2016 has a built-in dictionary and a set of grammatical rules to check the spellings and grammar of 

the text document. Incorrectly spelt words are displayed with a single red wavy line under them. The 

grammatical errors are indicated with a blue wavy line. The spell check starts from the position of the cursor 

and checks the complete document. A simple method to check the spelling of any word is as follows: 

Right-click on the word with a red wavy line. 

A Shortcut menu opens, displaying various suggestions. 
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Let's Know More 

We can also click on 

Spelling & Grammar 

button in the Proofing 

group on the Review tab 

to correct the spellings 

and grammar in the 

document. 

The Spelling task pane 

appears on the right side, 

highlighting the wrong 

spelling in red and 

displaying the list of 

suggestions. 

I 

erful only when ii 

V 

Knowledge is infimation  

Knowledge comes from o value unless yo 
JD sn.qocp 
a, 
J Niw Co..,,M 

Figure 5.13: Checking Spelling 
and Grammar 

t_ fr: 

Ifldw 

it is acted upon. Knowledge comes from learning. It is of no 

value unless you put it into practice. 

Select the correct spelling from 

the suggestions list. 

Word 2016 automatically replaces 

the incorrect spelling with the 

selected option. 

USING THESAURuS 

Thesaurus helps to improve our vocabulary by providing a list of synonyms 

(words with similar meaning), for any word. Follow these steps to use 

Thesaurus: 

Select the word for which you want to find synonyms. 

Click on the Review tab. Select the Thesaurus option in the Proof ing group. 

The Thesaurus task pane opens on the right side of the document window, 

displaying the list synonyms. 

Move the mouse pointer to the suitable word. Click on the drop-down 

button and select the Insert option. The existing word will be replaced 

with the new one. 

Proofing 

Knowldge is intorm1ation. It becomes powerful only when 

pow&ul 4' 

- ft +  

Quick View 

The shortcut key to check 

Spelling & Grammar is F7 

key. 

Quick View 

Press Ctrl+Delete and 

Ctrl-f Backspace key 

combinations to delete 

one word to the right or 

left respectively. 

 

Figure 5.14: Using Thesaurus 

    

     

The shortcut keys for Undo 
and Redo commands are 

Ctrl~Z and Ctrl+Y 

respectively. 

 

WORD 2013 

     

To activate the thesaurus option in Word 2013, click on REVIEW tab and select the' 
Thesaurus option from the Proofing group. 
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) Word 2016 application opens a blank document with the temporary name Documenti. 

) Making changes in a document is called editing. 

> To perform any action, like copying, moving, finding, replacing, deleting or formatting the text, we 

need to select the textfirst. 

>  You can insert data in an existing document in two different ways- Using Insert Mode and Using 

Overtype Mode. 

) Copy and Paste options are used to duplicate the text. 

> The shortcut keys for Undo and Redo commands are Ctrl +Z and Ctrl + Y respectively. 

> Incorrectly spelt words are indicated with a red wavy line under them. 

Grammatical errors are indicated with a blue wavy line. 

SECTION  -  A 

A. Fill in the blanks. 

1. The is a blank area in the left margin of a document. HINTS 

 

Editing 
2. The  is a reserved place that stores data temporarily. 

Selection Area 

3. Making changes in the document is called  File 

Thesaurus 
4. To print the document, click on  

.  Clipboard 

tab> option. Red 

''  Print 
5. Incorrectly spelt words can be seen with wavy line under them. 

6. The option provides a list of synonyms and antonyms. 

B. State True or False. 

1. The shortcut key to close a document is Ctrl~C. 

2. In MS Word you can share documents on the internet. 

3. The shortcut key to jumpto the end of the current document is Shift + Ctrl + End. 

4. To select a sentence, hold down the Shift key and click anywhere on the sentence. 

5. To select a paragraph, double-click anywhere in the paragraph. 
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Ctrl+Delete F 

Shift+Home I 

Ctrl+X, Ctrl+V 

Ctrl+C, Ctrl+V 

Ctrl+A I 

Deletes one word to the right 

Cuts the text and places it at a new place 

C. Match the following. 

Copies the text from one 
place and pastes it at another place 

I Selects the entire text 

Selects the text from current position 

to the beginning of a line 

D. Application-based questions. 

1. Raman has made a project, but he does not know how to check the spellings and grammatical 

mistakes in a document. What steps will you suggest him? 

2. Sonam has added some extra paragraphs in her document. The teacher has asked her to delete them. 

How will you help her to do this? 

SECTION  -  B 

A. Multiple-choice questions. 

1. In how many ways you can insert text in an existing document? 

a.3 b.2 c.4 

2. Grammatical errors are indicated with a  

a. Red wavy line b. Green wavy line c. Blue wavy line 

3. Which among the following shortcut keys is used to select one character to the right? 

a.Shift+—' b.Shift-f- -- c.Shift+1 

4. Which is the shortcut key for Undo command? 

a. Ctrl~Y b.Ctrl+U c.Ctrl+Z 

Learning 
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B. Answer in one word or one sentence. 

1 Which shortcut key is used to check spelling and grammar in Word document? 

2. Which command is used to reverse the action of the Undo command? 

3. Name the mode that is used to replace the existing text in a document. 

4. Write the shortcut key to delete one word to the left. 

C. Answer the following questions. 

1. List any three features of a word processing software. 

2. What do you understand by Editing? How can you insert text in a document? 

3. Explain the use of Thesaurus option in Word 2016. 

4. Differentiate between moving and copying the text. 



Everyday is a perfect gift for us to use, 

Hours waiting to be felled in any way we ch000se. 

Each morning brings a hope that rises with sun, 

Each evening brings the sweet content that comes with work done. 

> Type the above lines and save the document as 'The Perfect time' using the File tab> Save option. 

> Press Ctrl + 0 key combination to open the document 'The Perfecttime'. Make corrections in it. 

> Now using the Insert mode, add the text 'of time' before 'for us to use' in the first sentence. 

> In the second sentence, place the cursor before the letter 'e' of 'felled' and replace 'e' with 'i' using 

the Overtype mode. Likewise correct the spelling of 'ch000se' with Spellings & Grammar option. 

> Insert the word 'quite' in the third sentence, before the word 'hope'. Similarly add 'well' before the 

word 'done' in the fourth sentence. 

> Selecttheword 'content' in the last sentence and replace itwith word 'comfort' usingThesaurus option. 

) Save your document again by usingthe Ctrl + S key combination. 

) Close the Word application by clicking on the File tab > Close. 

[  LAB SESSION 

ONLINE LINKS 

 

Looking For More 

  

To know more about Office 2016, visit the following websites: 

> http://www.gcflearnfree.org/office201  6/word201 6/1 

> http://www.gcflearnfree.org/office2016/word201  6/3 

> http://www.gcflearnfree.org/office2016/word201  6/5 
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The ribbon of Word 2013 looks similar to that of the Word 2016 ribbon, except that the menu names appear 
in capital letters. 
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FORMATIUNG A DOCUMENT 

LEARNING IN THIS CHAPTER 

r Changing Font Type, applying Bold, Italic, and Underline effects 

• Changing Text Colour, Text Case, and Text Aligment 

Applying Superscript and Subscript effects 

• Creating Bulleted or Numbered list 

• Applying Borders and Shading 

i Applying Drop Cap effect 

Formatting means changing the appearance of a document to make it attractive. We can create and 

design appealing documents by: 

Changingfont and its size Highlighting certain words Adjusting line spacing 

Setting margins and tabs Aligning text on a page Creating bulleted/numbered lists 

Changing text case Applying border Changing text styles and colour 

Formatting effects can be applied using the Home tab, which contains: font formatting commands 

(Font group), paragraph options (Paragraph group), text stylescommands(Styles group), copying and 

moving commands (Clipboard group), finding, replacing, and selecting commands (Editing group). 
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Figure 6.1:  Groups Selected on the Home tab 

WORD 2013 

CHANGING THE FONTTYPF 

The characters of a specific size and design used for typing the text are called Fonts. Word 2016 

provides various types of font options. When you open Word, the text appears in default font type that 

is, Calibri (Body) with 11 point size. 
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Figure 6.2: Changing Font Type 
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Font 

Invention — Bold 

Invention — Italic 

Invention - Underlinel 

Let's Know More 

Font Size refers to the 
overall size (generally 

height) of the letters. To 
change the size of font, 
click on Font Size 12 - 

drop-down list in the Font 
group on the Home tab 

and select any font size 
from the displayed list. 

Let's Know More 

;
Catbrtt5 11 - A A 

B I 

On selecting text, a small 

pop-up window appears, 

which has the basic 

formatting command 

buttons. 

To change the font type: 

>- Select the text. Click on the Home tab. 

>  Click on the drop-down arrow next to the 

Font box in the Font group. A list of fonts 

appears. 

Choose the desired fontfrom the displayed 

font list. Observe the change. 

Starting from 2007 onwards, the 
default font in Microsoft Word has been set to 
Calibri with 11 point size, whereas, in the 
previous versions, it was Times New Roman. 

APPLYING BOLD, ITALIC, AND UNDERLINE EFFECTS 

The font style options, such as Boldface, Italic, and Underline are used to 

emphasise the text and catch the reader's attention. 

Bold It makes the selected word 

darker than the rest of the 

text. 

Italic This effect emphasises the 

text by slanting it to the 

right. 

Underline It emphasises text by 

placing a line under it. We  Figure 6.3: Applying Font Style Effects 

can underline a word or 

sentence alongwith spaces. 

To apply anyfont style effects: 

>  Selectthetext. 

> Click on the button  B1  or ru  or 1JJ in the Font group on the Home tab. 

Word 2016 provides a variety of formatting options, which can be selected 

from the Font dialog box on the Home tab. Simply click on the Font dialog box 

launcher in the Fontgroup. 

Word 2013 

Quick View 

Press the shortcut keys to 

apply and remove the 
given effects: 

Ctrl~B for bold 

Ctrl~I for italic 

Ctrl+U for underline 
In Word 2013, you can also bold, italic, underline the text by selecting B, I, U effects 
in the Fontgroup on the HOME tab. 

ComprswlthKLPS  



CHANGING TEXT COLOUR 

Word 2016 provides an option to change the colour of the text. 

Selectthe text and click on the Home tab. 

> Click on the drop-down arrow next to the Font Color button on 

4 the Home tab. Select the desired colour from the displayed 

Font color menu. 

You can also make customised colours by selecting the More 

Colors option. 

Word 2013 

Similarly in Word 2013, you can change the colour of the text by selecting 
the Font Color button on the HOME tab in the Font group. 

E' CHANGING TEXT CASE 

4 
[U utornatic 

• Theme Colors 

U RRUU*UU 

ilIi huh 
Standard Colors 

UUU.. 
i More Colors,.. 

gradient 

Figure 6.4: Changing Colour of Text 

You can change the case of the existing text without retyping it in Microsoft Word. To do so, select the 

text and choose the Change Case option available in the Font group. Word 2016 provides five types of 

case conversions, which are as follows: 

  

Explanation 

 

Example Font Case 

  

    

Sentence case 

 

Capitalises the first letter of the selected sentence. 

 

This is a test document. 

lowercase 

 

Converts the selected text to lowercase. 

Converts the selected text to uppercase. 

 

this is a test document. 

THIS IS A TEST DOCUMENT. UPPERCASE 

  

Capitalize 
Each Word 

 

Changes the first letter of each selected word to 
uppercase. 

 

This Is A Test Document. 

tOGGLE cASE 

 

Converts the case of every selected character in 
reverse manner, i.e., a capital letter will convert into 
lowercase and vice versa. 

tHIS IS a tEST dOCUMENT. 

Word 2013 

In Word 2013 also, you have similar font cases to format the text. 
-I 
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ALIGN LEFT: It places the selected text towards the left margin. By 
default, the text is aligned to the left margin. 

S.t..*, Mc$*..t 19 

HANGINGTEXTALIGNMENT 

Alignment refers to the positioning of text 

on a page. It is always better to set the 

alignment before typing. We can also 

select an entire document and then 

change the alignment of text. 

Word 2016 provides four types of 

alignments, which are as follows: 

How to align the text? 

Select the text. Click on any desired alignment button in the Paragraph 

group on the Home tab. 

) Observe the change in the alignment. 

Figure 6.6: Applying Center Text Alignment 

Word 2013 

To change the alignment of the text, select any of the above given options in the 
Paragraph group on the HOME tab. 

On which group do you 

find the change case 

option? 

Learning 
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Figure 6.5:  Alignment Buttons 

Press Shift + Enter to 

insert blank lines in the 

bulleted or numbered list. 

CENTER:  It sets the text in the center of the left and right margins. This 
alignment is mostly used for titles/headings. 

ALIGN RIGHT:  This aligns the selected text towards the right margin. It is 
often used for placing dates or reference in a document. 

JUSTIFY: It places the text evenly between the left and the right margins. 
It is mainly used for designing books, magazines, and newspapers. 

Computer is a boon to the mankind. People feel 
helpless without computer. Today, it is a source of 

employment for millions of people. Computer is the 
greatest invention on earth especially for students. 
In fact, everyone is getting advantage while using 

information and communication technology. 

S.- -= - 
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I- 

40= '  
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3- 

Paragraph 

Let's Know More 

The Redo button[on 
the Quick Access Toolbar 

can also be used as a 
Repeat Typing' tool to 

rewrite a previously typed 

word. 
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Type 'M2' and select .2  from it. 

Click on the Font dialog box launcher on the 

Home tab. The Font dialog box appears. 

Select the Superscript check box under the 

Effects section. Click Ok. 

You will notice that '2' will be placed above the 

baseline. 

Similarly, you can apply the Subscript effect to the 

text. 
Figure 6.7: Applying Superscript Effect 

> Click on the Superscript or Subscript x, button present in the Font group on the Home tab to 

apply the respective effects on the selected text. 

)' To apply other special effects on the selected text, click on the Font dialog box launcher T . Select 

the required font effect in Effects section, like Strike through, Small caps, All caps, Hidden, etc. 

Word 2013 

In Word 2013, also you can apply various formatting effects to the text by following the same steps as w 
have mentioned above. 
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APPLYING SUPERSCRIPT AND SUBSCRIPT EFF 

Superscript option places the selected text slightly above the baseline. On the contrary, the Subscript 

option places the selected text slightly below the baseline and makes it appear smaller than the rest of 

the text. : a - 

Select the text and click on the Bullets 

button in the Paragraph group on the Home 

tab. Select the bullet style of your choice. 

You will find that the selected text is bulleted and 

the indents are automatically adjusted to 

separate the text from the bullets. 

Learning 
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Creating Bulleted or Numbered List 

EATING BULLETED OR NUMBERED LIST 

We can format lists in a document by using bullets 

and numbers. A bullet is a small graphic symbol that 

is added before an item in a list. 

To apply bullets to the text, follow these steps: 
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Know the Fact 

   

To highlight text, select it 

then click on the 

Text Highlight Color 

tool. choose the desired 

colour and observe the 

change. 

II... 

Figure 6.9: Selecting Borders and 
Shading Option 

I 

FIgure 8.10:  Borders and Shading Dialog Box 

Learning 
Computers with  KIPS 

Similarly, you can apply a numbered list to the text. To apply the numbering 

effect on the text. 

Click on the Numbering button in the Paragraph group and select any 

list style of your choice. 

APPLYING BORDER AND SHADING 

To improve the appearance and legibility of the text, we can add a variety of 

border and shading effects to the paragraphs and the entire page. 

Select the text. Click on the drop-down 

arrow next to the Borders button in the 

Paragraph group on the Home tab. 

Select the Borders and Shading option 

from the displayed list. 

The Borders and Shading dialog box 

appears as shown in Figure 6.10. 

Now, set the border style. 

Choose the Box option under the Setting 

section and select the border style. Select 

the line style underthe Style list box. 

Quick View 

The shortcut key to 

apply/remove the 

Subscript effect is Ctrl +=. 

Press Ctrl+Shift+= to 

apply/remove Superscript 

effect. 

r Let's Know More 

You can also use a picture, 

symbol or a font as a 

bullet by clicking the 

drop-down arrow of 

Bullets button and 

selecting Define New 

Bullet option. 

To apply picture as bullet, 

select Picture tab from 

the 

Define New Bullet dialog 

box and pick any picture 

from the file. 



6 4) fl C'  l Knadq s o,mtm Wød ki rn 0 

c. Fit  Home  lowit Oetqn  & ¶trIet c-. MaInc Rev.tw Vcw 

j ¶NorntI 

AaBbCcD 

ii ¶ 

c& P.tO9raph 

Knowledge is powerful information only when it is 
acted upon. Knowledge comes from learning. It is of 
no value unless you put it into practice. 

Poot I of I 34 wOrth L knott 

C,Iib,i (Boay) A A 

B I 

oflt 

AaBbCcD  AaBbCi 

"No Sp,,. Hcading 

Stylti 

• 

To apply a border around a page, click on the Borders drop-down arrow and select the Borders 

and Shading option. Select the Page Border tab in the Borders and Shading dialog box. Choose the 

desired Setting, Style, Color, and Width of the border. Click OK. The defined borderwill be applied around 

the page. 

Word 2013 

To apply the border and shading to the paragraphs click on the HOME tab, select the Border button in the" 
Paragraph group and follow the above mentioned steps. 

Click on the drop-down list of Color and select any colour of your choice. 

Choose the line width from the Width section. 

Click on the drop-down list of Apply to section and select the Paragraph option. 

Click OK and observe the change. 

Figure 6.11: Border is applied to the Paragraph 

APPLYING DROP CAP EFFECT 

Drop Cap is a text formatting option in Word 201 6 that allows a user to enlarge only the first letter of a 

paragraph. It is used to give a fancy look to a document. 

To apply the drop cap effect, follow the given steps. 

Select the first word of your document. Click on the Insert tab and select the Drop Cap button 

in the Text group. 

Select the desired option from the drop-down menu. Or 

Select the Drop Cap Options from the list. 

Learning 
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The Drop Cap dialog box appears. Select the 

Dropped option. 

Select the options, if necessary. Click on OK button. 

Observe the change. 
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igure 6.12: Using Drop Cap Effect 

  

In Word 2013, click on the INSERT tab and choose the 
Drop Cap option in the Text group to enlarge only the 

first letter of a paragraph. Its application is exactly the 

same as in Word 2016. 

        

RECA! 
> Formatting means changingthe appearance of a document to make it attractive. 

> Fonts are the characters of a specific size and design used fortyping the text. 

> Bold effect makes the selected word darker than the rest of the text. 

> Italic effect emphasises the text by slanting it to the right. 

> Underline effect places a line under the selected text along with spaces. 

> Alignment refers to the positioning of the text on a page. 

> Superscript option places the selected text slightly above the baseline. 

> Subscript option places the selected text slightly below the baseline and makes it appear smaller 

than the rest of the text. 

> A bullet is a small graphic symbol that is added before an item in a list. 

> Border button is used to apply borders around the selected text, paragraph, and the entire page to 

improve the appearance of the text. 

> The Drop Cap effect enlarges the firstletterofa paragraph. 



SECTION - A 

A. Fill in the blanks. 

1. By default, text is aligned to the margins. 

2. We can change the font size by clicking on the Font Size drop-down button on the  

tab. 

3. To select the Drop Cap option, click on the tab. 

4. A is a small graphic symbol that is added before an item in a list. 

5. option places the selected text slightly above the baseline. 

 

Superscript Bullet 

 

B. State True or False. 

1. By default, Word 2016 sets the font to Calibri (Body). 

2. Justified alignment means that the text is aligned with the left margin. 

3. We can apply bullets to a text document by selecting the Bullets button. 

4. The Bold button is used to display the text in a darker shade than the rest of the text. 

5. The drop cap effect reduces the first letter of a paragraph. 

6. A word or a sentence can be underlined along with spaces. 

C. Application-based questions. 

1. Ritika has designed a colourful Birthday card. The teacher has advised herto apply Border and Shading 

effect around the card. Help Ritika to apply the effect. 

2. The Science teacher of Madhav has asked him to create a list of the students of his class and entertheir 

marks into it. Which option should be use to create a numbered list? 

Learning 
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SECTION  -  B 

A. Multiple-choice questions. 

1. alignment is used to set the text evenly between the left and the right margins. 

a. Left b. Center c. Justify 

2. The Font Size box is available on the tab. 

a. Insert b. Font c. Home 

3. What is the shortcut keyto apply/remove the Subscript effect? 

a. Ctrl + = b. Ctrl + Shift + = c. Ctrl + Shift 

4. Which among the following commands is used as Repeat Typing tool? 

a. Undo b. Redo c. Paste 

B. Answer the following questions. 

1. What does Formatting mean? 

2. How will you change the font in your document? 

3. List the various change case options available in Word 2016. Explain any two. 

4. Define the term text alignment. Name the types of alignments available in Word 2016. 

5. What is the difference between Superscript and Subscript option? 
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SAFETY ON THE ROAD 

> While crossing the road, look on both sides and if it is clear, only then cross the road. 

> Do not play on the road. 

> Use Zebra Crossing or Subway to cross the road. 

> Cross the road carefully. 

What do Traffic Lights signify? 

1. Red means Stop. 

2. Green means Go. 

3. Yellow means wait. 

 

MY ACTIVITY 

  

Learning While Playing 

 

   

The hint box with various formatting terms is given on the left. Find and colour these words 

in the given letter grid. 

Type the following text on Safety Rules without applying any formatting effects. Later on, apply the 

formatting effects by following the instructions given below. Save the file with the name, 'SAFETY'. 



LINKS Looking For More 

To learn more about Word 2016, visit the following websites: 

> https://support.office.com/en-us/article/Forrnat-a-document-in-Word-201  6- 

780772c6-9506-4081 -afd 1-aff9aabl 9f Sf 

> http://www.gcflearnfree.org/word2016/6  

Write a letter to your Mother and convey thanks to her for allowing you to go for picnic. 

Format the document by applying the effects you have learnt so far. 

Using Creativity 

Learning 
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INSTRUCTIONS 

> Select the heading, 'SAFETY ON THE ROAD', change its Font to Impact and Font Size to 16. 

. Click on Underline and Bold buttons in the Font group on the Home tab and center align the 

heading. 

> Click on the Font Color drop-down list. Select the heading and apply red colourto it. 

> Select all the points and change their Font to Anal Black, Font Size to 12, and apply Italic effect to 

them. Click on the Bullets button in the Paragraph group and observe the change. 

> Select the text, 'Zebra Crossing' and 'Subway', change their Font Size to 14 and apply green 

colour to it. 

> Select the heading 'What do Traffic Lights signify?'. Underline the heading and center align it as 

given in the figure. 

> Highlight the last three points with yellow colour and apply Numbering effect to them. 

> Save the file using Ctrl+S key combination. 



WORKING WITH PAINT 3D 

 

LEARNING IN THIS CHAPTER 

 

• Paint 30 

• How to Open Paint 3D? 

• Components of Paint 3D window 

• Drawing a 2D circle 

Drawing a 3D sphere 

• Working with the Brushes tool 

P  Erasing a drawing 

• Saving a drawing 

Students, look around your classroom. Observe carefully all the objects kept in the class. What 

do you see? You will see different objects in different shapes, sizes, and colours. 

Take out your notebook and pencil and draw the following objects: 

Note that all these objects have only length and breadth properties. In other words, they are 

flat. Such objects that have only two dimensions, i.e., length and breadth properties are called 

2D or two-dimensional objects. 

Next, take out the following objects from your school bag. What do you see now? 

I 

    

GEOMETRY BOX ERASER 

You can see that all these objects have an additional property which is height, along with length 

and breadth. Can you pick the picture that you have drawn? No! But can you hold the objects 

which you took out from your bag? Yes! 

Such objects which you can hold are called 3D objects.These objects that have height, length, and 

breadth properties are called 3D orthree-dimensional objects. 

From the above exercise you have learnt the difference between 2D and 3D shapes, i.e., 2D 

objects are the objects that have only length and breadth properties while 3D objects have 

height, length, and breadth properties. 
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Iook at the pictures given below. Put a tick mark in the given box only if you see 

a 3D object. 
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A computer has a Paint 3D program that helps us to make colourful drawings. 

PAlNT3D 

Paint 3D is a wonderful tool designed by Microsoft for drawing different types of 3D Objects. 

The earlier version called MS Paint, is still significantly used for creating 2D shapes. Along with 

the ease of using, Paint 3D also has a vast library of 3D objects and tools to draw pictures. 

HOW TO OPEN PAINT 3D? 

> To open Paint 3D, type Paint 3D in the search box. 

> Select Paint 3D App option, from the list of results. 

Open Paint 3D and select New option to open a new project. 

Figure 7  1 Starting Paint 3D

Learning 
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2D Shapes: This tool is1  

used to draw2D shapes. 

3D Shap:  This tool is 

used to draw3D shapes. 
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Brushe: It displays different 
types of brushes in the Marker 
panel. 

Tex: This tool is 
used to add text. 

3D Library: You can use 

this tool to add 3D objects. 

+ Add colour 

Matte 

0 
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COMPONENTS OF PAINT 3D WINDOW 

Menu:  It contains the1  
various options to work 

icker: This option is used 
to add different stickers. 

Figure 1.2.  Components of Paint 3D Window 

DRAWING A 2D CIRCLE 

Click on the 2D shapes option. 

SelecttheCirdetool  H:  from the2Dshapes panel. 

Move the mouse pointer to the canvas area. 

The pointer changes into a '+' sign. 

Hold down the left mouse button and drag the mouse to draw a circle. 

Release the mouse button when a circle is drawn. 

Add colourto the circle by selecting a colourfrom the Fill group. 



I 

000A 
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Figure 7.3: Drawing a Circle 

FILLING AN OBJECT WITH COLOUR 

) To fill an object with any colour, click on the Brushes option. 

> Select the Fill tool and then select the colour of your choice 

from the colour pallete. 

> Move the mouse pointer to the object that you want to fill. 

) Click the left mouse button. The selected colour will be filled in the 

object. 

Fill Tool 

£ & 
I * 

Figure 7.4: Filling Object with Colour 
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Circle Tool 

0 

Let's Know More 

Shortcuts like Ctrl+A, 

Ctrl+C, and Ctrl+ V work 

quite well when it comes 

to selecting, shifting or 

removing any unwanted 

objects in Paint 3D. 

Let's Know More 

When you launch the 3D 

Paint app, the area where 

you draw is called Canvas. 

Quick View 

> If you want to reverse 

your last actions, use 

Undo command or Ctrl +Z. 
Redo command is used 

to reverse the effect of 

Undo command or you 

can also use Ctrl~Y key 

combination. 
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DRAWING A 3D SPHERE 

: Click on the 3D shapes 

option. 

Select the Sphere tool 

from the 3D shapes panel. 

Move the mouse pointer 

to the Canvas area. 

To draw a perfect sphere, press the Shift key while using the Sphere tool. 

   

WORKING WITH THE BRUSHES TOOL 

> Click on the Brushes option. 

Select Oil Brush from the Brushes Panel. 

The pointer changes into a 

'+' sign. 

Hold down the left mouse 

button and drag the 

mouse to draw the sphere. 

Release the mouse button when the sphere is drawn. 

Add colour to the sphere by selecting the Edit colour option from the 3D selection panel. 

You can increase the size 

of the brush by dragging 

the Thickness slider. 

Move the pointer to the 

Canvas area. 

Press and hold down the 

left button of the mouse 

and drag the mouse to 

draw different lines. 

Figure 7.6: Using Brush Tool 
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ERASING A DRAWING 

> The Eraser tool is used to erase any part of a drawing. 

Select the Eraser tool : from the Brushes panel. 

) Change the size of the Eraser by dragging the Thickness slider. 

> A square will appear in the Drawing area. Hold down the left mouse 

button, and move it on the area you want to erase. 

q G I ç -.. K) •4-' *p... 

Figure 7.7: Using Eraser Tool 

OPENING A PROJECT IN PAINT 3D 

If you want to work on any old drawing that you had saved previously, the 

first step will be to open that file. To open a saved project, follow the 

given steps: 

Erase tool 

and 
Brush Tool 

If you want to clear all the 

objects from the drawing 

area, select all the objects 

and click on the Delete 

button. 

Let's Know More 

When an object gets 

selected, the handles at 

the right, top, and bottom 

let you rotate the object. 

Select the desired 

project from the Saved 

Projects list. Figure  7.8:  Opening a Project in Paint 3D 

Quick View 

You can use the F12 key to 

save a Paint 3D drawing 

for the first time. 
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Click on the Menu icon 

and select the Open 

option. 

The Open panel will 

display a list of projects 

saved in Paint 3D. 
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AVING A DRAWIN( 

            

            

It is important to save your drawing 

after finishing the work. Once it is saved, 

you can reuse it any time. 

Click on the Menu option in the side 

bar. Select Save as option. 

To save your drawing, select the 

Image option under Save as copy. 

       

Save as copy 
Coo,. • °. I 

   

          

 

U Opeo 

        

            

I 

      

Save in Paint 3D project 
YoO b b to .d4 tI.t pOOI 

  

         

            

            

   

awe 

   

V 

    

            

Figure 7.9: Saving a Drawing 

i,vi v4' rorbetteruonceptl;IarIty 

A. To draw an icecream cone, select the 3D Cone and Hemisphere from 3D objects. 

B. To draw an umbrella, select the Hemisphere tool from 3D objects and lines from 2D 

objects. A 

'V 
RECAP 

) A computer has a Paint 3D program that helps us to make colourful drawing. 

> In Paint 3D, the area where you draw is called Canvas. 

) The Redo command is used to reverse the effect of Undo command. 

> In Paint 3D, the Erase tool is used to erase a picture. 

) The F12 shortcut key is used to save a Paint 3D drawing. 



EASERR 

SECTION - A 

A. State True or False. 

1. The 3D objects are used to draw 2D shapes. 

2. The Eraser tool is used to erase any part of a drawing. 

3. You can increase the size of the Brush by dragging the Thickness slider. 

B. Rearrange the jumbled letters to make a meaningful words. 

SECTION - B 

A. Multiple-choice questions. 

1. Which 3D tool is used to draw a sphere? 

a. Pencil b. Eraser c. Sphere 

2. Which tool is used for adding colours to an object? 

a. Fill b. Thickness Slider c. Oil Brush Tool 

3. Name the area where you draw in Paint 3D. 

a. Canvas b. Sketch c. Window 

4. Which option is used for adding stickers? 

a. 3D Library b. 2D Objects c. Stickers 

B. Answer in one word. 

1. Which slider is used to change the thickness of any object? 

2. Which tool will you use to draw a ball? 

3. Which option is used to start a New Project? 

4. Where will you find the different types of brushes in Paint 3D? 
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GROUP DISCUSSION For Concept Clarity 

  

• 

Discuss the following topic with the students. 

> 3Dvs2Dobjects 

Using 3D and 2D tools make an attractive Birthday Card for your Mother. 
7 — 

 

PROJECT WORK Using Creativity 

LAB SESSION Perfection Through Practice 

1. Draw the following 3D Figure: 

> Use the 3D Sphere, Hemisphere, 3D Cube, and Capsule tool. 

> To draw uniform windows, use Copy and Paste options. 

2. Draw the given 2D Figure: 

> Use the Rectangle, Line, and Oval shapes to make the inner 

pattern. Use the Polygon shapes to make triangles. 

> Savethefile. 

Learning 
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INTRODUCTION TO SCRATCH 

RNING  IN THIS  CHAPTER 

cratch - A simple language 

r tarting Scratch 

r Main components of Scratch 

r  Moving a Sprite 

' Drawing a colourful circle 

r Making a duplicate copy of Sprite 
r  Saving a Scratch project 

Opening a Saved project 

Students! How do you express yourfeelings to yourfamily and friends? Through language, isn't it? 

A language is a medium to talk or write. You may speak different languages, like Hindi, English or any 

other regional language, but to talk to any person, you need a common language, which both of you 

can speak and understand. 

In the same way, if you want to give instructions to a computer, you need to learn the language that a 

computer understands. A computer does not understand the language that we speak. It understands 

onlyfew special languages of its own. These are known as Programming Languages. 

A programming language has a set of instructions, using which you can make a computer do any 

activity that you want. 

SCRATCH - A SIMPLE LANGUAGE 

Scratch is one of the easiest computer languages. Students can use Scratch to create their own games, 

animated stories, and projects with great ease. 

Any task that we perform includes many steps. It should be completed, step-by-step, in a 

particular sequence. 

Suppose Kabir's teacher asks him to bring notebooks of 

his class from the Computer lab. As he is new in the 

school, she guides him how to reach the Computer lab. 

She gives the following instructions to Kabir: 

Move to the left from the class and go straight. 

After crossing five classes, take a left turn. 

Then, move forward and after crossing six classes, 

take a right turn. 

Aftercrossingthree classes, you will reach the Computer lab. 

Likewise, a computer also follows step-wise instructions to complete any task. These step-wise 

instructions are known as a Program. 
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Know the Fact 

Scratch is used in more 
than 150 countries and 
available in 40 different 

languages. 
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Let's Know More 

STARTING SCRATCH 

To start Scratch, follow the steps given below: 

Figure 8.1: Starting Scratch 

Click on 
Scratch 2. 

_______ Scratch 
Window opens! 

I I 
I I- 

' ________ 
-S 

Fact File 

Scratch was developed by 
the Lifelong Kindergarten 

Group at the 
MASSACHUSETTS 

INSTITUTE OF 
TECHNOLOGY(MIT) Media 

Lab, led by Mitchel 
Resnick in 2003. 

MAIN COMPONENTS OF SCRATCH 

Figure 8.2: Components of Scratch Window 

SPRITE 

Sprite is a small graphic character that performs actions in a Scratch project. 

Scratch provides a number of in-built Sprites. Cat is the default Sprite in 

Scratch. 

Scratch 3.0 is the latest 
version of Scratch. It 

comes with a lot of exiting 
new features such as, 
dozens of new sprites, 

backgrounds and sound. 

It was released on 2nd 
January 2019. 

Scratch can easily run on 
different operating 
systems, including 

Windows, Mac OS, and 
Linux. 
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Know the Fact 

The official website of 
Scratch is 

www.scratch.rnit.edu  



Hold and drag Drop 

turn ( degrees turn (I degrees 

It is the main working area where the Sprite moves and performs actions, as perthe given instructions. 

Here you can watch stories, play games, and run Scratch projects that you have created. 

BLOCKS PALETTE 

The Blocks palette contains the set of blocks, which is used to program the Sprite and give actions to it. 

Each block performs specific tasks in a project. It is used to create scripts in Scratch. The blocks connect 

with each other just like a jig-saw puzzle. 

A script is a collection of step-wise instructions that are given to a Sprite to do a specific task. A script 

consists of at least two blocks. 

SCRIPTS AREA 

The Scripts Area is the place where you create a script for a Sprite to do a particular task. The script is 

created by dragging the instructions from the blocks palette and dropping them step-wise one below 

the other. A script is also called a Program. 

Let us learn how to drag and drop the blocks in the Scripts Area: 

Figure 8.3: Scripts Area 

MOVING A SPRITE 

All the instructions related to the movement of a Sprite are given underthe Motion block menu. 

Let us create a Scratch project to move the Sprite in circular motion. 
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niove steps 

turn ( degrees 

x: 115 
y 15 

I. 
Scripts Costumes SouncL 

Motion 

Looks 

Sound 

Pen 

E)ata 

Events 

Control 

Sensing 

Operators 

More Blocks 

move steps 

turn ( degrees 

turn $) degrees 

point in direction 

point towards rnousa-pwnter 

Open the Scratch window. 

By default, the Motion block palette is displayed on the left side of the Scratch window. 

Click on the move steps block and drag it to the Scripts Area. Change the step number from 10 

to 20 by typing in the number box. Click on the block. You will notice that the Sprite moves the 

specified number of steps. 

Click on the turn ( degrees block. Now, drag and drop it on the Scripts Area. Place it below 

 

the move steps block. 

Keep clicking on any block in the Scripts Area. 

Observe that the Sprite is moving 20 steps forward and turning 1 5 degrees in a circular motion on 

the stage. 

Figure 8.4:  Moving and Turning the Sprite 

KNOW ABOUT MOTION BLOCKS 

Let us understand the use of the Motion blocks, which we have used in the project. 

              

      

This block moves the Sprite 20 steps in forward direction. 

To move the Sprite in backward direction, type the number with a preceding 

(-) minus sign. For example, -20. 

   

n'tove steps 

   

       

       

This block is used to turn the Sprite in clockwise direction. To turn the Sprite 

  

turn ( degrees 

  

    

in anti-clockwise direction, use turn $) degrees block. 
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Figure 8.5: Drawing a Colourful Circle 

n,ove ctep. 

ton. (" 
pen down 

cot pen co, to 

dcng. po..  caine by 

This block draws a line as the Sprite moves on the stage. pen down 

This block is used to set the thickness of the pen to a specific number. You 

can change the thickness of the pen by typing in the number box. 
set pen size to 0 

To change the colour of the pen, use change pen color by block. change pen color by () 

ctn.p 

n.00e 

p.'.. do.... 

.h..nq.' pen color by 

cot p.'..  '..'  to 

if on edge, bounce 

DRAWING A COLOURFUL CIRCLF 

The blocks in the Pen block menu allow the Sprite to draw lines on the stage, change the colour, and 

the thickness of lines. Let us add some more blocks to the previous Scratch project. Observe the 

movement of the Sprite on the stage. 

Clickonthe Pen blockmenu. ____ 

Select the ________ block from the Pen 

block palette. 

Drag out the block and place it underneath 

the turn  ( degrees block. 

Now, click and pull the set pen Size toO 

block onto the Scripts Area. Place it below 

the ten down block. Change the value from 

ito 10. 

Drag out the 

    

block from the Pen block palette and drop it at the end. change pen color by 

 

10 

 

   

    

Change the valuefrom 10to20. 

Keep clicking on any of the blocks in the Scripts Area till the Sprite completes its colourful circle. 

KNOW ABOUT PEN BLOCK 

Let us understand the use of Pen blocks that we have used in the project. 

MAKING A DUPLICATE COPY OF SPRITE 
0 tik2OIlwt6.,. 

To create a duplicate copy of the Sprite, 

the   block is used. 

Drag out the blocks from the Motion and 

Pen blocks palette as shown in Figure 8.6. 

Snap the blocks together onto the Scripts 

Area. 

I- cOn 

Figure 8.6: Making Duplicate Copies of Sprite 
Learn inq 
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Figure 8.7:  Saving a Project 
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Scratch 2.0 projects are saved with the extension .sb2. 

00o. AJF4sr.1 

0.3. 5054.., lI 

Figure 8.8: Save Project Dialog Box 

Fev Edit 1pn About 

New 

Open 

Save 

Save as 

Record Project Vsdeo 

Looks 

Sound 

Pen 

Data 

Change the values of the blocks as given in Figure 8.6. 

Click on any of the blocks to create the duplicate copy of the Sprite. 

Notice, as the Sprite reaches the edge of the Stage, it will bounce back and change its direction. 

     

i on  edge, bounce 
The block is in the Motion block menu. It is used to turn the 

Sprite in the opposite direction as it reaches the edge of the stage. 

    

SAVING A SCRATCH PROJECT 

Once you finish the project, always save it before closing the Scratch window. 

To save the project, follow the given steps: 

Click on the File menu in the Menu bar. 

Select the Save option from the drop-down 

list. 

The Save Project dialog box appears. 

Choose the desired location where you 

want to save your Scratch project. 

5000P,*.t 
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0000m*.*o N.o. 125 
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=
0004 p0100/00 1012512054 :15 .,. Te.7 0oe.,nl 

Fden.,n 000.td100*d 

Assign a name to your project in the File name 

text box. 

Click on the Save button. 

Your Scratch project will be saved. You can open it 

whenever required. 

OPENING A SAVED PROJECT 

To open a saved project, follow the given 

steps: 

Click on the File tab. Choose the Open 

option from the drop-down list. 

Figure 8.9: Opening the Scratch Project 
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The Open Project dialog box appears. 

Select the project that you want to open. 

Click on the Open button. 

OpenProject 

4— -1• Th.sPC D, 

Oranioe - New folde, 

* Name 
* Quick access 
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lest Document 

window. 
Pictures 

TO 010 16 80 

harry 

htlps.....www.irctc.co.in_eticknfing.print... 

4/21/2016 5:31 PM 

4/16/2016 3:55 PM 

SF2 F:le 

Adobe Acrobat 0... 

Book 4 I IPMS0 for Win32 4/I 6/20163:01 PM Shortcut 

II Beans Book 4 
ipmsg350_inslallor64 

IMl005.HB.pnp.aiin64-on 
6/2/2015 3:06 PM 

6/3/20 IS 4:37 PM 

Application 

Appbcat.on 
IT Beans Book 5 j New Teat Docsamtnt 4/16/2016&36PM lest Docunlenr 
Sereersshot Tis I Scratch Project 4./27/2016 4:59 PM S82 Pie 

OneOnve 
scratch 4/27/2016457 PM 082 P:le 

File L All Piles Ci 

Open Cancel 

Figure 8.10: Open Project Dialog Box 

> A computer understands only a few special languages of its own. These are known as programming 
languages. 

) Scratch is one of the easiest computerlanguages. 

> Students can use Scratch to create their own games, animated stories, and projects with great ease. 

) Sprite is a small graphic characterthat performs actions in a Scratch project. 

) Script is a collection of step-wise instructions that are given to Sprite to do a specific task. 

)' Scripts Area is the place where you create a scriptfora Sprite to do a particulartask. 

> Allthe instructions related to the movement of Sprite are given underthe Motion block menu. 

> The blocks in the Pen block menu allow the Sprite to draw lines on the stage, change the colour, and 
the thickness of lines. 

SECTION  - 

A. Fill in the blanks 

1. is one of the easiest computer languages. 

2. A computer follows step-wise instructions to complete any task, which is known as  

3. is a graphic character which moves on the stage. 

4. The blocks in the block allow the Sprite to draw lines on the stage, change 

the colour, and the thickness of lines. 
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5. In Scratch, the Sprite moves on the when you run a program. 

    

Program -' Sprite 

 

HINTS Stage Pen Scratch 

B. State True or False. 

1. A computer understands the language that we speak. 

2. Blocks Palette is the place where you create a script for the Sprite to do a specific task. 

3. A script consists of at least two blocks. 

4. You can turn the Sprite only in clockwise direction. 

5. Scratch 2.0 projects are saved with the extension .sb2. 

C. Label the parts of the Scratch window. 

  

  

  

  

  

  

  

  

     

D. Application-based questions. 

1. Aarav wants to make a Scratch project wherein he wants to move the Sprite in forward direction by 

20 steps. Suggest him the appropriate blockto perform this action. 
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2. Shreya wants to change the thickness of the pen while drawing a trail behind the Sprite. Suggest her 

the right blockthat she can use. 

SECTION - B 

A. Multiple-choice questions. 

1. Scratch 2.0 was officially released on 2013. 

a. July 4 b. May 9 c. June 2 

2. contains the set of blocks, which is used to program the Sprite. 

a. Blocks Palette b. Stage c. Scripts Area 

3. block draws a line as the Sprite moves on the stage. 

a. b. 

4. Who is the founder of Scratch? 

turn degrees 

 

a. James Gosling b. Tim Berners-Lee c. Mitchel Resnick 

B. Answer the following questions. 

1. What do you know about Scratch? 

2. What is a Sprite? 

3. Explain any two main parts of the Scratch window. 

4. What is the use of Pen block? 
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Brush our teeth Go to school Have breakfast 

Watch TV 

A Have a 
shower 

LAB SESSION Perfection Through Practice 

A. Practice the following programs and see the change in the Sprite's movement. 

pn down 

d.nq.' pn ro3or by 

s.,t pen we  o 
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MY ACTIVITY Learning While Playing 

   

The teacher asked the students to make a chart, displaying their daily routine of work, in 

correct sequence. Number the steps in the order in which they are done. 



£4 1St' 144' It.,  Abosl 

£4 II..  4  15. 

Using Creativity PROJECT WORK 

Draw the given images in Scratch with a colourful Pen style. 
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B. 
(1) Drag the following blocks in the Scripts Area of the Scratch window and save the 

project. 

..I.,.., b....,.. 

Modify the following blocks in your script and observe the difference while running the program again. 

(2) Drag the following blocks in the Scripts Area of the Scratch window and save the project. 

Modify the following blocks. Run the script again and observe the difference. 

5th Ofr* (Ste 

> Remove change pen size by and blocks from the script. 

move steps 

turn ('4 degrees 

pen down 

change pen color by 

set pen size toO 

stamp 

turn ) degrees 

pen down 

change pen color by 

naove step 

turn ('4 0 degrees 



LEARNING IN THIS CHAPTER 

• Creating a New project 

• Changing the appearance of Sprite 

• How to make a Sprite say something? 

Open 

Save 

Save as 
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Figure 9.1: Opening  a New Project 
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Figure 9.2: Selecting Costumes Tab 

SIMPLE MOVEMENT OF SPRITE 

* Repeating actions 

• Adding sound 

Students! In the previous lesson you learnt about the components of Scratch, i.e., how to open Scratch 

and make simple projects using blocks from Motion and Pen block menu. In this lesson, we will learn 

about changing the appearance of Sprite, changing its colour and size, repeating actions, making the 

Sprite say something, and adding sound effects to a project. 

New Coslumes Soun 

 

> CREATING A NEW PROJECT 

Open Scratch window. Click on the File menu. 

Choose the New option. A new project opens up with a 

default cat Sprite on the stage. 

CHANGING THE APPEARANCE OF SPRITE 

When you start a new Scratch project, it begins with a cat Sprite. You can edit the looks of the Sprite by 

changing its costume. The Looks block menu controls the look of the Sprite. 

To change the Sprite's look, follow the given steps. 

Click on the Costumes tab to see and edit the Sprite's costume. 

The New costume options are displayed as shown in Figure 9.2. These options are: Choose 

costume from library , Paint new costume /, 

Upload costume from file , , and New costume 

from camera . Here, we will learn the method to 

choose a costume from the library. 

Click on Choose costume from library button. The 

number of choices will appear in the Costume Library 

dialog box. 

Select the Animals option from the Category section. 
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Now, select the Looks block category. Click and 

pull out the chancje effect by 

 

block onto the 

Scripts Area. Place it below the nave steps 

block. 

rips About 

NOTE The cii.irige effect  ' block changes the 

colour and other graphical effects applied to the Sprite 

by the specified number. 

Motion 

Looks 

Events 

COntrol 

Sensng 

• 

Now, pick  the" block and snap it below 

the thaee effect block in the script. 

Click on any of the blocks to run the block stack. 

Observethe Sprite changing its costume and colour. 
Figure 9.6: Sprite Changing its Appearance 

Figure 9.5: Sprite Costumes List 

salpts Costumes Sounds 
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Figure 9.3: Costume Library Dialog Box  Figure 9.4:  Selecting Animals Category 

Select butterflyl-a Sprite and click OK. 

Observe that the new costume will be added under the Costumes list as well as displayed on the 

stage. 

Selectthe Scripts tab and click on the Motion block. 

Drag out the movesteps block from the 

Motion category and drop it on to the Scripts area. 

Click inside the number box and change the steps 

valuefrom 10to20. 

Notice that the Scripts tab and the Costumes tab share the same space. You can move back and 

forth by clicking on each tab at the top. 
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Figure 9.7:  Sprite Saying a Message 
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Figure 9.8:  Changing the Size of the Sprite 

HOWTO MAKEASPRITESAYSOMEIHING? 

You can also make the Sprite say a word or sentence in a 

Scratch project. The _______ block allows the Sprite to say 

something in a voice bubble. 

Let us look at the example given below. 

Click the Looks block category. Drag the elIo! 

block from it and drop it onto the Scripts Area. 

Now, click on the Control block and drag the 

wait  0 block to the Scripts Area. Snap these two 

blocks together. This block makes the Sprite wait for 

the specified number of seconds before moving to the 

next block of the script. 

Again, select the Looks block category and place the say How are you' 
fØ: block beneath the 

wait block. This block allows the Sprite to say something for the specified number of 

seconds. 

Type in the message: 'How are you?' inside the text space of the block. 

Drag out the say block again and drop it at the end of the script. Change the text of the 

block to 'lam good'. 

Click on any of the blocks to run the block stack. 

KNOW MORE ABOUT THE LOOKS BLOCK 

change size by This block is used to change the size of 

the Sprite by the specified amount. 

Let us make a Scratch project using blocks that have been 

explained to you. Place the blocks one by one as shown in 

Figure 9.8. Now, click on the script and observe the Sprite 

changing its colour and size. 

R&tAffl MBU1'S 

Repeat instructions help in controlling the execution of the program. You can repeat the actions of the 

Sprite as many times as needed. You will get various blocks to repeat the actions in the Control block 

category. Blocks held inside the 

mentioned in the block. 

block are repeated for the specified number of times 
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Let us learn to use the repeat block in the next example. Know the 

> Drag the block and turn CS degrees 

block from the Motion block move steps 

lock as 

move steps 

) Select the Pen block menu. 

Drag out the  stamp  block 

and drop it below the 

block. 

> Now, place them inside the 

shown in Figure 9.9. 

) Click on any block to run a 

stack and observe the 

repeated actions. 

Figure 9.10: Sprite Repeating Actions 

KNOW MORE ABOUT THE CONTROL BLOCK 

The blocks held inside this block will be in a loop that never 

ends, unless the Stop button is clicked. 

TO RUN A SCRIPT The block is in the Events block and the most 

used block in Scratch. The image of a flag shows how the 

block is connected with the actual green flag. The scripts 

that begin with this block will run once the Green flag 

hasbeenclicked. 

4 

To move a block of commands anywhere in the Scripts Area, click on the 

top block of the script and drag the stack to the place where you want to place it. 

ADDING SOUND 

There are many ways to add sound to your Scratch project. Here, we will discuss 

the blocks present in the Sound block menu that are used to add sound. 

Learning 
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> Pick the  ut0 
 block and place it onto the 

Scripts Area. Change the value from 10 to 15. 

palette and drop them onto the Scripts area. 

> Change the value in both the blocks to 30. 

repet  0 
turn CS degrees 

move steps 

stamp 

Figure 9.9:  Stack 

A loop is a sequence of 
instructions that is 

repeated until a certain 
condition is satisfied. 

Let's Know More 

Stop button• 
The Stop button is placed 
on the top-right corner of 

the stage. It is red in colour 

and used to stop the 
project at any time during 

execution. 

Let's Know More 

Green flag 

It is a tiny icon 
placed at the top-right 

corner of the stage screen. 
clicking on the green flag 

will run the script. 
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> To change the Sprite's looks, we can use the Costumes tab. 

There are four options to change the costume of a Sprite-Choose costume from library, Paint new 

costume, Upload costume from file, and New costume from camera. 

) The say Hello block allows the Sprite to say something in a voice bubble. 

> The --'• block is in the Events block, and is designed to start a script. 

> The Stop button is used to stop the project at any time during execution. 

> The Sound block contains many blocks to play sound in your Scratch project. 

> The Control block category includes various blocks to repeatthe actions of the Sprite. 

Make the script by dragging out the blocks as shown in Figure 9.11 and stack them on top of each 

other. 

Click on the Script to play the project. You will hear the sound of a cat, i.e., 'Meow' and drum beats. 

  

Jp : '. File V Edit' Tips About - 

 

  

Sciipts Costumes Sun! 

   

I 
Mellon 

Sound 

Events 

Control 

Sensing 

Operators 

More Blocks 

Hello Friends! 

 

Pen 

Oats 

    

Figure 9.11:  Adding Sound in a Project 

KNOW MORE ABOUT SOUND BLOCKS 

play oiiiid until done 

 

This block will play the specified sound. The script will pause until the sound 

has finished playing. 

   

play drum or beat5 

 

This block plays a drum sound for a specified number of beats. You can change 

the drum type by clicking on the drop-down arrow next to the number and the 

number of beats by changing the value in the box. 

Learning 
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SECTION - A 

A. Fill in the blanks. 

1. When you start a new Scratch project, it begins with a Sprite. 

2. The block allows the Sprite to say something in a voice bubble. 

3. The Stop button is placed on the right corner of the Stage. 

4. The block allows the Sprite to wait for the specified number of seconds. 

5. The block will play the specified sound, pausing the script until the sound 

has finished playing. 

HINTS Top play sound ( ) until done say () Cat Wait ( ) secs 

B. State True or False. 

1. You can make a Sprite say something in a voice bubble. 

2. You can not change the costume of the Sprite with the help of Costumes tab. 

3. The Sound block menu contains blocks to play sound in your Scratch project. 

4. The Stop button is of green colour. 

5. You can repeat the actions of a Sprite as many times as needed. 

C. Application-based questions. 

1. Vansh wants to make a Scratch project where he wants to use different costumes of the Sprite. 

Suggest him the correct block to do this. 

2. Prakhar wants to stop the Scratch project before it ends. Suggest the correct button to stop the 

Scratch project any time during the execution. 

Learning 
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D. Match the following. 

   

  

Control 

   

 

Looks 

 

   

 

Motion 

 

   

       

 

turn ( fl  degrees 

    

  

I Sound 

      

       

change color effed by 

    

  

Pen 

 

I 

  

   

    

       

SECTION - B 

A. Multiple-choice questions. 

1. The block controls the looks of a Sprite. 

a. Looks b. Sound c.Control 

2. The Scripts tab and the Costumes tab share the space. 

c. Entire 

3. The say 

c. Circle 

4. To move a block of commands anywhere in the Scripts area, click on the block 

of the script. 

a. Top b. Bottom c. Left 

B. Answer in one word or sentence. 

1. Name the blockthat allows the Sprite to change the costume. 

2. Which block allows the Sprite to say something forthe specified number of seconds? 

3. Which option do we use to choose Sprite's costume from the library? 

a. Line 

a. Same b. Different 

block allows the Sprite to say something in a voice 

b. Bubble 



ii 

4. Name the block that makes the Sprite wait for some seconds. Where can you find this block? 

5. Name the block that is used to run the script, again and again. Mention the block category where it is 

found. 

C. Answer the following questions. 

1. Name any two blocks from the Looks block menu in Scratch. 

Name the options that are available for changing the costume of a Sprite. 

3. Briefly explain the use of block in Scratch. 

4. Which block should be used to play the sound of a Sprite? 

5. What is the purpose of using the block? 

Learning 
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A. Make the following projects in Scratch to create different patterns. 

move steps 

turn degrees 

waatOsecs 

pen down 

set pen we toO 

set pen color to 

repeat  Q 
n-love steps 

wait sets 

turn degrees 

move steps 

pen down 

change pen color by 

set pen size to 0 
repeat  0 

move steps 

turn ( degrees 

wait  0  secs 

move steps 

turn degrees 

wait  0  sets 

move steps 

pen down 

move steps 

turn degrees 

move steps 

wait  0  sets 

turn ( degrees 

pen down 

set pen size toO 

(hJlILJ( ,)e color by 

r.p.at0 

say Let u make a Zig-Zag! for 

sets turn ( degrees move 

degrees wait  0  sets wait 

steps move steps turn ( 

sets turn ( degrees move 

degrees wait  0  sets wait 

steps move steps turn 

turn ( C_) degrees move 

degrees wait  0  sets wait 

steps move steps turn 

sets turn ( degrees move 

D degrees -s wait 

turn 

200 steps 

sets 

degrees 

steps 

secs 

degrees 

steps 

sets 

degrees 

steps 

sacs 

degrees 

move steps 

move steps 

walt  0  r-- 

  

I did it! say 

 

  

say I dd a 

wait 

turn 

move 

wait 

turn 

move 

uad 

turn 

move 

wait 

turn 
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LAB SESSION Perfection Through Practice 



LOO 

Souni 

I Pen 

I 

IE. 
Ccr• 

Sensfn 

l ..  

I 

block 

GROUP DISCUSSION 

.t ft  .4 r '. , t' lips AboW 

lI. 
Saipts Costumes 

Motion 

Looks 

Events 

Control 

Sensing 

• Operators 

MOre Boccs 

Sourl(t 

Pen 

Data 

Wash Your Hands 
Before and After 

Eating. 

B. Make the following project in Scratch using the blocks displayed on the Scripts Area. 

After creating the project, modify the 

script as perthe instructions given below: 

a. Changethecolourofpen 

b. Increasethenumberof steps 

c. Let the Sprite say something 

d. Replace the block with 

Fg. Edit' T) About £ i- : 

UrilUed 

For Concept Clarity 

Discuss the topic Different ways of changing the look of a Sprite with the students. 

JROJECT WORK Using Creativity 

The teacher asked Priya to make a Scratch project, describing the HeaTth Hygiene 

Habits. Suggest some of the suitable blocks to display the following sentences on the 

stage. The first one has been done for you. 

Wash your hands before and after 

eating. 

Take a bath every day. 

Brush your teeth in morning and 

evening. 

Avoid eating junkfood. 

Trim your nails regularly. 

1:11 I 

1.  

2.  

3.  

4.  

5.  

Add creativity to your project by changing the appearance of the Sprite and adding new costumes while displaying a 

new habit. Also, add some sound effects to your project. 

Learning 
Computers with  KIPS  



Chapters 5-9 

A. Fill in the blanks. 

1. The tool is used to add 3D objects in your drawing. 

2. In Scratch, is a collection of step-wise instructions given to a Sprite. 

3. The refers to the overall size (generally height) of the letters. 

4. Word 2016 opens a blank document with the temporary name  

5. A is a sequence of instructions that is repeated until a certain condition is satisfied. 

HINTS 

     

 

Documenti 

 

Script Loop Font size 3D Library 

   

B. State True or False. 

1. We should not press the Enter key at the end of each line. 

2. The Open panel displays a list of projects saved in Paint 3D. 

3. Scratch is one of the easiest computer languages. 

4. Justified alignment means thatthe text is aligned with the left margin. 

5. In Scratch, a new project opens up with default Cat Sprite on the stage. 

C. Complete the following shortcut commands. 

To create a new document in Word + S 

To remove the Subscript effect Alt +  

Beginning of the current document Ctrl +  

 

To save a project in Paint 3D 

  

Shift+ +Home 

     

To close the Word application 

  

 

Shift +  

  

     

One character to the left 
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Chapters 5-9 

A. Choose the right answer. 

1. Where can you find the Eraertool? 

a. Brushes panel b.2Dshapes c.3D shapes 

2. The is a small graphic characterthat performs actions in a Scratch project. 

a.Sprite b.Stage c.Script 

3. To move a block of commands anywhere in the Scripts Area, click on the  

block of the script. 

a.Top b.Bottom c. Left 

4. The button is used to halt the Scratch project during execution. 

a. Halt b. Stop c.Greenflag 

5. How many scroll bars are there in Word 2016? 

a. 1 b.4 c.2 

B. Answer in one word. 

1. Which block has all the instructions related to movement?  

2. Name the tool to add text in your drawing in Paint 3D. 

3. Which extension is given to the drawing saved in Scratch?  

4. Name the block that controls the looks of the Sprite.  

C. Answer the following questions. 

1. Which tool in Paint 3D is used to increase the size of the brush? 

2. What is the green flag button used for? 

3. Name any two blocks present in the Control block menu. 

4. What do you understand by Editing? 

5. Define the term 'alignment'. Name the types of alignments available in Word 2016. 



EPAINT3D 

tudents! You have learnt how to draw in Paint 3D using various tools. Let us make beautifu 

and colourful drawings with it. 
-  

Project 1:  Create these drawings in Paint 3D. 

    

I 

  

I 

 

[1 
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COOD MANN!! 

+ Always respect your elders. 

+ Greet your elders with respect. 

+ Always throw garbage into the dustbin. 

+ Never scribble on walls. 

+ Wash your hands before and after every meal. 

+ Never eat uncovered food. 

+ Always clean the table after taking meals. 

+ Avoid eating junk food, like chips, burger, pizza, etc. 

IHI©ppuj T©d'i J©j 

T ime you spend planning, 

E fforts you make. 

A dds power to learning 

C hances you take. 

H ats off to our teachers, (& 
E ach one a gem. 
R ecognised now. We 
S alute them! * 

MS WORD ___ 

Project 1: Open MS Word and make a poster on Good Manners. Set it on your desktop as a 

wallpaper and take a printout of the poster. 

INSTRUCTIONS 

+ Heading Font - Showcard Gothic 

+ FontSize-20 

+ Colour-Red 

4 Text Font - Chaparral Pro 

+ FontSize-14 

Text Colour- Black 

+ FontStyle-Bold 

Make the faces of children, balloons, and stars in Paint 3D. Bring them in the MS Word HINTS;>. 
 document by using the Cut and Paste commands. 

Project 2: Create a poster on Happy Teacher's Day in MS Word. 

INSTRUCTIONS 

4 HeadingFont-Skinny 

4 FontSize-36 

4 Colour-Blue 

4 Text Font - Anal Rounded MT 

Bold 

+ FontSize-16 

+ Text Colour - Green and Red 

Learning 
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Project Open MS Word and make a beautiful poster on  Clean India. 

 

CLEAN 

_ iN DI*' 
Clean up the Clutter, 

b4 

Shun the Lifter. 

Join each one of us, 

To make  INDIA  Glitter! 

\/ 

Project 4:  Open MS Word and make a beautiful poster on the  Important Factors to 

be Disciplined. 

IMPORTANT FACTORS 
to be DiscpCmne 

• Wake up earltj  in the mornin6. 

• D0 not be late to school. 

• Do not make the classroom dirtij. 

• Speak politebj. 

• Beobeclient to your elders. 

• Do ljourhorneworkre6ular1tj. 

> Use Text Effects from the Font group to add a reflection to the text. 

HINTS > 

  

 

Download the desired pictures from the Internet by selecting the Insert > Online 

Pictures option. 
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TUX PAINT 

Project 1: Draw a Forest Scene  in Tux Paint. Project 2:  Create a bea utiful  Sea Scenery. 

Froject 3:  Draw the  oad View  by using 
the tools that you learnt in Tux 
Paint. 

Project 4:  Create the  Hot Air Balloon 
Scenery. 

HINTS> 
We used various tools, like Lines tool, Paint tool, Stamp tool, Brush tool, and Magic 
tool to make these paintings in Tux Paint. 

Learning 
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Plan your work, 
when you are 
going to study. 

 

HABITS OF 
HIGHLY EFFECTIVE 

STU DENTS 

°roject 2:  Create a project on Steps to prevent Global Warming in Scratch. Add 

movement to the Sprite and change the costume with each new sentence. 

Learning 
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Steps to pr: v  -  t Global Warming 
Plant more trees. 

Plant more trees. 

Conserve water. 

Use eco-friendly fuels, like solar energy, 

CNG, etc. 

Use recyclable things. 

Turn off lights when not in use. 

Replace bulbs with CELs and LEDs. 

SCRATCH 

Project i Create a project and let the Sprite say the following points in voice bubbles. 

Add movement to the Sprite and change its costume with each new sentence. 

HABITS OF HIGHLY 
EFFECTIVE STUDENTS 

Plan your work. when you are going to study. 

• Set a regular time and place to study. 

• Never put off your study session due to lack 

of interest in the subject. 

• Start with the most difficult subject. 

• Study with a focused mind and avoid 

distractions. 

• Avoid rote learning but study with 

understanding. 

• Rewrite the important key points in your 

own words. 



PATTERN & MARKING SCHEME 

Section (1) Logical Reasoning (2) Computers & IT (3) Achievers Section 

No. of Questions - 
Marks per Ques. 

5 

      

   

25 

 

5 

2 

 

      

    

1 

  

        

Total Questions : 35 lime: 1 hr. 

SYLLABUS 
Section 1: Patterns, Analogy and Classification, Coding-Decoding, Mirror Images, Embedded Figures, Alphabet Test, Ranking Test, Grouping of Figures, 
Figure Matrix, Geometrical Shapes, Days and Dates & Possible Combinations. 
Section 2 : Fundamentals of Computer, General Information about Computers, Storage Devices, Parts of Computer, Uses of Computer, Input and 
Output Devices, Introduction to Internet, MS-Paint, Introduction to MS-Word (Opening, Closing, Saving and Printing a Word document, Components of 
MS-Word window, Editing commands like Cut, Copy, Paste, Undo and Redo, Moving in a document using Home and End Keys), Latest Developments in 
the field ot IT. 
Section 3 : Higher Order Thinking Questions - Syllabus as per Section 2. 
Questions are based on Windows land MS-Office 2010. 

N CO 
SOF NATIONAL CYBER OLYMPIAD 

Fig. (X) 

(A) (B) 

(0) 

1 Which of the following options will complete the pattern in Fig. (X)? 

LOGICAL REASONING 

(C) / 

— Marker (B) (A) (C) Natural 

pencil 
Calligraphy (D) 

brush 1 
— Watercolor brush 
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NATIONAL CYBER OLYMPIAD 

Visit www.sotworld.org  for more details. 

2. Which is the heaviest ball? 

(A) (B) (C) 0 (D) 

3 If is coded as +, 0 is coded as - , 9 is coded as > and is coded as <, then which of the 

following is NOT true? 

(A) 2594 (B) 5037 (C) 1O595 (D) 40297 

COMPUTERS AND INFORMATION TECHNO. 

4. Which of the following icons is used to draw circle in MS-Paint of Windows 7? 

(A) (B) 0 (C) N (D) ('j 

     

Which of the following is an input device? 

    

(A) (B) (C) (D) Both (A) and (B) 

     

6. Select the INCORRECT match of brushes in MS-Paint of Windows 7 with their corresponding names. 



7. Select the odd one out. 

(A) Google (B) Bing (C) Yahoo (D) Internet Explorer 

8. Which of the following statements about a computer is NOT correct? 
(A) You can watch movies on it. (B) You can solve your sums on it. 
(C) You can play games on it. (D) You can cook food with it. 

9. The key that erases characters towards the left is  

(A) (B) D&ol (C) Enc,r .4_-J (D) Spacebar 

  

       

10. Find the odd term out. 
(A) Keyboard (B) Mouse 

  

(C) Monitor (D) Joystick 

 

       

11. The control unit of the computer controls the  
(A) Working of the computer keyboard (B) Flow of electricity within the computer 
(C) Flow of data in the computer 
(D) Performance of all arithmetic and logical operations 

12. MS-Paint is a Windows program that is used for  
(A) Calculations (B) Writing letters 
(C) Drawing purposes (D) Preparing presentations 

13. Which of the following is NOT an example of search engine? 

(A) Go ogle (B) facebook (C) bing (D)  YAHOO! 

 

ACHIEVERS SECTION 

 

14. Alia wants to create a shortcut for MS-Word 2010, so that she can 
quickly access it. But she does not know the correct sequence 
of steps required to follow to create a desktop shortcut. Help 
her by rearranging the given steps in the CORRECT order. 
(A)4> 1>2>6>5>7>3 
(B) 1> 2> 4>7> 3>6> 5 
(C)4> 3>2>7> 1>5>6 
(D) 6> 1> 5>7> 2>4> 3 

P1 

2 c$MoioO cefadsi 

3. cd Os (sie V*) OA 

4. 

R4d 

& GobIiuo5cWsid2OtO 

7 Sc5.c5 esi pJpcsi. 

S 

1 5. Identify the following. 
— It is a device that converts textual data into spoken sentences. 
— It is used to read the text information to blind persons. 
— It translates the entered text into spoken words. 

(A) (B) ________ (C) (D) 

SPACE FOR ROUGH WORK 

ANSWERS 

NCO 1. (C) 2. (C) 3. (D) 4. (8) 5. (B) 6. (C) 7. (D) 8. (D) 9. (A) 10. (C) 11. (C) 12. (C) 

wthKtPS   

13. (B) 14. (A) 15. (A) 
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